BASS Project User Guide

Basic Astronomical Spectroscopy Software

Document Version: 1.4
Application Version: 1.4 Rev 0
Date: 26th April.2014
Author: John Paraskeva
## Contents

1. **BASS Project User Guide** ........................................................................................................ 4
   1.1 Introduction .......................................................................................................................... 4
   1.2 Installation .......................................................................................................................... 4

2. **Main Screen** .......................................................................................................................... 6
   2.1 Menu and toolbar function .................................................................................................. 7
      2.1.1 Project Functions ......................................................................................................... 7
      2.1.2 Search function ............................................................................................................ 10
      2.1.3 Profile functions ........................................................................................................ 11
      2.1.4 Advanced Tools functions .......................................................................................... 12
   2.2 Chart Settings .................................................................................................................... 15
      2.2.1 Chart Tab ..................................................................................................................... 16
      2.2.2 Colours tab .................................................................................................................. 16
      2.2.1 X Axis tab .................................................................................................................... 17
      2.2.2 Y Axis tab .................................................................................................................... 18
      2.2.3 Advanced tab .............................................................................................................. 19
      2.2.4 Ranges Tab ................................................................................................................. 21
      2.2.5 Notes tab ..................................................................................................................... 22
   2.3 Context Sensitive Chart Menu ........................................................................................... 22
   2.4 Profile Properties ................................................................................................................ 23
      2.4.1 General tab ................................................................................................................... 23
      2.4.2 Line tab ......................................................................................................................... 25
      2.4.3 Y-Axis tab ..................................................................................................................... 27
      2.4.4 Calibration tab .............................................................................................................. 28
      2.4.5 Correction tab .............................................................................................................. 30
   2.5 Image Strips .......................................................................................................................... 31
      2.5.1 Image Strip View type selection .................................................................................. 32
      2.5.2 Context Sensitive Image Strip Menu .......................................................................... 33
      2.5.3 Manual Alignment of profiles ..................................................................................... 35
      2.5.4 Identification of image strips ....................................................................................... 35
   2.6 Selection menu .................................................................................................................... 36
      2.6.1 Selection regions ......................................................................................................... 36
      2.6.2 Region Selection Tool .................................................................................................. 37
   2.7 Image processing menu ....................................................................................................... 38
      2.7.1 Image Profile number & caption ............................................................................... 38
      2.7.2 FITS Header ................................................................................................................ 38
      2.7.1 BeSS Settings .............................................................................................................. 39
      2.7.2 Save Image As .............................................................................................................. 39
      2.7.1 Save As 1D .................................................................................................................. 39
      2.7.2 Hot Pixel removal ....................................................................................................... 40
      2.7.3 Black and white levels ............................................................................................... 40
      2.7.1 Horizontal Flip ............................................................................................................. 44
      2.7.2 Rotate/Tilt image ........................................................................................................ 44
      2.7.3 Smile & Slant Correction ............................................................................................. 46
      2.7.1 Resize Image screen ................................................................................................. 49
      2.7.2 Normalise Flux Scale ................................................................................................. 49
      2.7.3 Bulk Image Manipulation screen .............................................................................. 52
   2.8 Stack Images ........................................................................................................................ 53
      2.8.1 File Menu ..................................................................................................................... 54
      2.8.2 Image Menu ................................................................................................................ 54
      2.8.3 Zoom Menu ................................................................................................................. 54
      2.8.4 Light Images ............................................................................................................... 55
      2.8.5 Image Alignment ........................................................................................................ 56
      2.8.6 Dark/Blas/Flat .............................................................................................................. 57
      2.8.7 Stacking Process .......................................................................................................... 57
   2.9 Stack and Align Profiles ...................................................................................................... 59
   2.10 Crop X-Axis Range ............................................................................................................. 62
      2.10.1 Zoom in ....................................................................................................................... 62
      2.10.2 Zoom out .................................................................................................................... 63
   2.11 Wavelength Calibration ..................................................................................................... 63
      2.11.1 New Calibration ........................................................................................................ 64
1 BASS Project User Guide

1.1 Introduction

BASS Project is a free Windows based application for amateur astronomical spectroscopy. The application was designed with new users in mind and is able to perform many of the standard spectroscopic processing tasks (e.g. calibration, instrument correction, continuum removal and background subtraction) with relatively few steps and without the need to save intermediate files.

BASS Project provides a rich set of tools for spectral profile processing and presentation of single or multiple spectra. It also provides image processing functions to crop and correct for rotation, tilt, smile and slant distortions for FITS and RGB (e.g. bitmap, jpeg & png) image formats. RGB files are automatically imported into a FITS format which makes it easy for new users to get started using a DSLR or web cam.

With image stacking and BeSS functionality added since version 0.0.1.2, BASS Project can be considered a ‘one stop shop’ for many users.

A BASS ‘project’ consists of one or more spectral images and their associated profiles, to which reference spectra, Planck temperature curves, element lines, labels can be presented.

For details of historical changes made to BASS Project see Appendix D – Amendment History

There is a Yahoo group at http://uk.groups.yahoo.com/group/astrobodger for users to access downloads, post their work and ask for help.

1.2 Installation

BASS Project is a .NET application that should run on Windows XP and Windows 7 or above PCs.

Download the MSI setup & installation package from the following link: https://dl.dropboxusercontent.com/u/87095951/Spectro/BASS%20Project/0.0.1.0/0.0.1.3/Rev%203/BASSPSetup.msi

Save this to a temporary location and then run accepting the default options.

Microsoft .NET 4 is the only perquisite required; this is normally already provided on most PCs. If not, the installer will prompt for it to be downloaded.

To minimise issues to do with Windows 7 access permissions, the default installation path is C:\Astrobodger\BASS Project. If this is changed to be under “C:\ Program Files\” then it may be necessary to provide administrative access and or set compatibility to XP.
BASS Project can be installed with the legacy BASS application on the same machine (so long as the installation folders are different).

Installation will create a Start Programs group that contains links to the user guide and the link to Uninstall.
2 Main Screen

BASS Project uses a single main screen interface with additional popup forms displayed as required. Functionality is available via traditional menus, the main toolbar and context sensitive “right mouse click” menus.

Most of the icons and buttons incorporate a short ‘tool tip’ description when hovered over.

The main screen loaded with an example project is shown below.

![Main Screen](image)

The screen is divided up into sections shown in the diagram below. Each is described in subsequent sections.
One or more spectral images (in FITS, RGB or DAT formats) can be loaded at any time. When an image is loaded, it is presented (as either a raw image or binned view) in an image strip under the toolbar. The spectral profile associated with the image is then plotted in the chart area. Clicking on one of the image strips will make it active.

The display of an image as a raw image or binned view is determined by the Image Strip view dropdown list selection (in the centre of the toolbar) and is detailed in its own section later.

The 'active' image strip is shown highlighted with a yellow border that also shows the sequence number starting from 1. The first profile (sequence = 1) has special significance since it determines the x-axis and calibration status of the chart. Where displayed, the y-axis values are based on the first profile.

The LH status bar shows pixel, wavelength (if calibrated) and profile intensity information for the active image corresponding to the position of the mouse.

The RH status bar shows the image size and dispersion (if calibrated) of the active image.

The chart area shows profiles associated with loaded images. The derivation of the profile from an image is detailed later.

2.1 Menu and toolbar function

The menu and toolbar functions are grouped into functional areas

2.1.1 Project Functions
A BASS Project is saved as a (*.bass) text file that contains the following:

- Chart settings (e.g. wavelength unit, title, colours, fonts, x and y axis settings)
- Links to one or more spectral profiles
- Spectral profile settings (calibration options, instrument correction options, scaling, displayed caption, active & background regions, colour & style)
- Links to one or more reference spectra and settings (caption, colour & style)
- Planck temperature curves and settings
- Element labels and chart settings.

The project function icons allow projects to be opened, and saved.

The new, open & save functions are also available via the File menu.

Edit Project settings are under the Chart menu. Project settings are described in their own section.

The file menu items provide an alternative means to access toolbar functions. There is one exception, ‘Add/Open Colour Image into RGB channels’, does not have a toolbar icon.

The Chart menu provides access to functions below
- **Refresh Chart** – redraws the chart. Also accessible via the F5 key.

- **Copy Chart to clipboard** - copies the chart to the Windows clipboard for pasting into another application.

- **Save Chart to file** – Saves the chart to an RGB picture file.

- **Copy Image Strips to clipboard** – Copies all the image strips as a single picture. This avoids having the yellow border visible (if you took a screenshot) and allows a picture larger than the screen size to be captured.

- **Save Image Strips to file** - Saves all the image strips as a single RGB picture. (See Copy Image Strips to clipboard above)

- **Crop X-Axis range** – Opens screen to selects all or a subset of the x-axis. Detailed in the Crop X-Axis Range section later on.

- **Edit Project Chart Settings** – Opens the Chart settings screen. Detailed in its own section later on.

**File extensions used**

A project file uses a four letter extension (*.bass). This should not be confused with image information “.info.bas” files that hold calibration and other data per image.

*When sending/sharing BASS images to other BASS users, be sure to include the BASS image information files (*.info.bas) located in the same folder as your actual image files.*
## 2.1.2 Search function

The binocular icon opens the modal Search screen. (Also available under the File menu)

This will search for images (in DAT, RGB & FITS formats) or complete projects (*.BASS) files depending on the “Filter” dropdown list.
The “Folder” textbox contains the folder to search under (including sub folders). The Search button will look under the specified “Folder” to match text entered in the filter textbox, (including * wildcard). A blank filter textbox returns all files. The results are shown in the grid underneath.

One or more profiles can be selected. Clicking Open will add the selected images to the project (& display them in the chart). The same images can be added more than once (in order to simultaneously display corrected and uncorrected views of a profile).

For projects, only one project can be selected. Clicking Open will close any existing images and load the selected project. (Only one project can be open at a time). Press the Close button to access the main screen.

2.1.3 Profile functions

An image having height=1 is technically a 1 dimensional profile, (or intensity series), where values from each column have been processed to single values (“binning”). The term “image” is used loosely here. It can refer to a 2 dimensional image (where conversion to a single dimension is calculated at run time) or a 1 dimensional image.

The toolbar image and profile functions are shown below

Add Images – the icon allows more images to be added to the chart.

Stack Images – the icon opens up the Stack Images screen which allows a single image to be created from a set of raw images.

Save Image – the icon allows the selected image to be saved

If no image strip is selected the following message will appear.

![Remove Image](image.png)
To select an image, just click on the image strip. A yellow border will indicate which image strip is selected (active). The sequence number and dimensions of the selected image strip are displayed on the RH status bar. If the profile is calibrated, the dispersion in wavelength unit per pixel is also displayed.

Remove Image – the icon prompts to save unsaved changes before removing the current selected image.

The 3 options are:
- Yes – Press Yes to confirm the filename and save the image. Once saved the image strip is removed
- No – Press No to remove the profile without saving changes
- Cancel – aborts the profile removal

Note – If the Shift key is held down when a profile is being removed then a prompt to delete the file will appear. If the file is local then it will be moved to the Windows Recycle bin if possible.

Edit profile settings – the icon opens the Profile Properties screen (described in its own section)

Crop X-axis – this opens the modal Crop X-Axis Range screen to enable you to zoom in on a region of the chart. This is a core feature that is critical to getting the most out of the application.

Refresh Chart – Redraws the chart. The F5 key will also refresh the chart.

Image Strip View – this dropdown list allows a choice of how the image list is to be displayed. See the Image Strips section

2.1.4 Advanced Tools functions
Calibration – an icon is provided to edit the existing calibration points of the top profile. If the profile is not calibrated then a new calibration is started.

The main Calibration menu is more useful than the toolbar icon since it allows a choice of options, including displaying calibration points on the chart. See the Wavelength Calibration section 2.11 for details.

Math Operations – an icon is provided to show the Operations screen.

The main Operation file menu includes sub menus for operations plus an option to stack image profiles (of the same width) together to create a new 1-dimensional image.

The result of the operation is displayed in a new image profile (added to the end of the list). The new image can be saved by right clicking on the new image strip and selecting “Save Image As” to invoke the standard File Save dialog.
**Note:** You will be prompted to save any new images created before saving a project.

Measurement & Element lines – an icon is provided to access the Measurement & Element lines screen. This allows measurements from the chart to be taken and also allows element lines to be plotted and/or displayed. See Measurements & Elements screen section.

Reference Spectra – an icon is provided to access the Reference Spectra screen. This allows one or more reference spectrum to be added to the chart. See Continuum & Response Shaper section.

Continuum & Response Shaper – an icon is provided to access the Continuum & Response Shaper screen. This allows curves to be created for instrument response correction and/or continuum removal. See Continuum & Response Shaper section.

Planck curves – an icon is provided to access the Planck Curves screen. This allows Planck temperature curves to be added to charts. See Planck Temperature Curve section.
**Resample Profile** - an icon is provided to access the Resample Profile screen. This allows a profile to be resampled. See Resample Profile section.

**Labels** - an icon is provided to access the Labels screen. This allows labels to be added to the chart and managed. See Labels Screen section.

**Animation** – an icon is provided to access the Animate screen. This allows animations to be created from profiles or saved pictures. See Animation section.

**Export Project** - an icon is provided to access the Export Project screen. This allows all profiles on the chart to be exported and displayed in a spreadsheet application. See Export Project Data section.

### 2.2 Chart Settings

The Chart Settings screen allows control of how the chart project is displayed. It is organised into separate tabs along the top. This screen is called from various menus and also by double clicking on the chart. The buttons on the base of the screen are common to each tab.

![Default Apply OK Cancel]

**Default** – A button that stores chart settings to be reused when a new project is started or the application next starts.

*Note: These settings are held in a file called “_default.bass” located in the application installation folder.*

**Apply** – A button that applies any chart setting changes made and keeps the screen open.

**OK** – A button that applies any chart setting changes made and closes the screen.

**Cancel** – A button to close the screen.

All chart settings are saved at a project level (i.e. you need to save the project).
2.2.1 Chart Tab

![Chart Settings dialog box]

**Title** – text is displayed on the top of the chart area.

**Sub Title** – text is displayed under the Title

**Chart height & width** - The width and height of the chart can be set to any sensible value, such as the width of your camera sensor (in pixels). It is can be useful to temporarily set the width to a high value that exceeds the screen width (e.g. 4000) and scroll horizontally to examine features in detail or when calibrating.

**Image strip height** – Specifies the height in pixels for each of the image strips.

**Background chart image** - Allows a background image file to be displayed in the chart behind the profiles. No scientific value, but you can put a meaningful ‘pretty picture’, perhaps an astronomical photo of your target, as the background

2.2.2 Colours tab

![Chart Settings dialog box for colours]

**Background colour**

**Text colour**

**Grid colour**
Clicking on the coloured icons invoke standard Windows colour selection dialogs.

2.2.1 X Axis tab

The X axis tab allows a choice of how the x-axis captions and grid lines are displayed

2.2.1.1 Doppler X Axis

Show Doppler Shift option checkbox - allows velocity (km/s) to be presented on the X axis relative to a stationary wavelength.
The Measurements screen will include velocity measurements when Doppler X Axis is enabled.

Rest wavelength – specifies the wavelength where velocity=0

X axis Doppler text – the X axis label text displayed when Doppler x axis is enabled. A parameter \(0\) can be used to show the rest wavelength within the x axis text.

2.2.2 Y Axis tab

The Y axis tab allows a choice of how the y-axis values and grid lines are displayed.

The Y axis Labels allows a choice of two options:

- None – no values are shown on y-axis
- Show Values – Y axis values are shown in ADU (analogue data units). RGB files are converted to FITS format when loaded.

The Y-axis text box allow a caption, such as ‘Intensity’, to be displayed on the Y axis.
2.2.3 Advanced tab

The 'Show Sequence in Legend' checkbox determines if the profile captions listed in the legend are prefixed with the sequence number.

The ‘Show line style in legend’ checkbox will show a section of the line rendered using the line style and marker.

Showing the sequence number or line style will be useful when there are a large number of profiles loaded and you need to know which is which, especially if a chart is printed in black and white.

Wavelength Unit – The dropdown list provides a choice of wavelength unit used. The current options are:

- Angstrom 1Å = 1 x 10^{-10} metres
- Nanometre 1nm = 1 x 10^{-9} metres
- Micron 1μm = 1 x 10^{-6} metres
The following settings are sensitive to the wavelength unit so need to be changed along with the unit.

- X-axis Doppler shift rest wavelength
- Processing range
- Continuum range for normalisation

When Apply is pressed and the wavelength unit is changed, a message box will offer a choice to apply an appropriate conversion factor from one unit to another. Click OK if you want the existing values converted, or click Cancel if you have already corrected the values for the new wavelength unit.

**Binning Method** – The dropdown list provides a choice of how intensity is calculated when displaying a profile. The current options are:

- **Average** – The intensity at a given pixel on the x-axis is the average of values in the y-axis (i.e. each column is averaged). The range of y-axis values summed can be defined using active binned region (otherwise it will average across the height of the image). See the Selection menu.

- **Exceed Background** – Similar to the ‘Average’ method but only includes values exceeding the average background intensity, assuming a background region has been set.

*Suggestions for additional binning algorithms are welcome.*

**Legend Font** – this button opens a font selection dialog to pick the font used to display the captions of loaded profiles in the legend.
Label + Notes Font – this button opens a font selection dialog to pick the font used to display Labels and Notes.

2.2.4 Ranges Tab

2.2.4.1 Processing range

The start & end wavelength processing values are used to restrict the range for processing operations such as ‘division’. Without this restriction spurious results where the camera response is low could spoil the results otherwise obtained.

2.2.4.2 Continuum range

This range is used to provide the default wavelength for the Flux Normalisation screen.
2.2.5 Notes tab

A multiline textbox allows comments to be held against the chart.

![Chart Settings](chart_settings.png)

The text will be formatted using carriage returns entered into the multiline text box.

Use the chart context sensitive menu (right mouse click on the chart) to display the notes entered on the chart.

2.3 Context Sensitive Chart Menu

Right mouse clicking on the chart area will pop-up the context sensitive chart menu.

- **Copy Chart to Clipboard** – copies the chart to the Windows clipboard for pasting into another application.
- **Save Chart to file** – allows the chart to be saved as a picture
- **Show Legend Here** – Displays the legend showing the list of profiles. The Legend top left corner is displayed at the last position the mouse was clicked.
- **Hide Legend** – hides the legend from view
• **Show Notes Here** - Displays the notes keyed into the Project Settings screen. The notes top left corner is displayed at the last position the mouse was clicked.

• **Hide Notes** – hides the notes from view

• **Labels** – Opens the Labels Screen to allow features of the chart to be annotated

• **Save Project** – Prompts user to save project to file.

• **Project Chart Settings** – open the Project Settings screen.

### 2.4 Profile Properties

The profile properties screen allows control of how the profile is displayed. It is organised into separate tabs along the top. This screen is called from context sensitive menus and also by double clicking on an image strip.

The buttons at the base of the screen are visible and apply across all the tabs:

![Buttons](image)

- **Previous button** – Navigates to the previous profile (when more than one is loaded)

- **Save button** – this updates the BASS image information file (.info.bas) so changes are reused for other projects using the same profile. (Changes are otherwise only applied to this project).

- **Remove button** – Prompts before removing the current profile (and closes the form)

- **Next button** – Navigates to the next profile (when more than one is loaded)

- **OK button** – this applies the profile changes to the project and closes the form

- **Apply button** - this applies the profile changes to the project, but keeps form open.

- **Close button** – closes the form

#### 2.4.1 General tab
The sequence and caption values are saved at a project level (i.e. you need to save the project). The Caption is also saved at a profile level, in the BASS image information file, (.info.bas) to be the default when opened in other projects.

Sequence dropdown list – allows the order that the profiles are displayed to be changed. E.g. setting sequence to “01” will move the associated image strip to the top of the image strip list. This is important since the first profile is used for image scaling.

Caption textbox – the text entered is displayed in the chart legend. The value initially defaults to the image filename.

Filename textbox – a read only textbox showing where the file is physically located

FITS Header button – for FITS images only, the button opens the FITS Header screen. This allows FIT header values to be viewed (and edited).

Image Strip Ignores Y axis scaling – This checkbox prevents the image strip display from brightening or darkening in sync with y axis scaling. This useful when showing profiles above one another while preserving the auto rendered image strip intensities.

In the LH example below, where the setting is turned off on all profiles. The image strip brightness and contrast are adversely affected when y-axis Scaling% and Offset% are manipulated to position the profiles within the chart.

In the RH example below, where the setting is turned on, the image strip brightness and contrast are not affected when y-axis Scaling% and Offset% are changed.
FITS button - for FITS images only, the button opens the FITS Header screen

BeSS button – for FITS images only, the button opens the BeSS (Be Star Spectra) settings screen

2.4.2 Line tab

The Line setting values are saved at a project level (i.e. you need to save the project).

Line Colour – The icon allows each profile to use a specific colour.

Line Width – The dropdown list allows the width of the profile to be set.
Line Marker – The dropdown list provides options to display a marker.

Note: Markers are most useful when zooming in on a small region of interest; otherwise they will just make the line thicker.

Note: The profile will be hidden from the chart when [no line marker] is used with Line Width =0.

Line Style – The dropdown list provides line style options. This can make it easier to differentiate between the profiles when printed in black and white.
2.4.3 Y-Axis tab

The ‘Data Multiplier’ and ‘Data Offset’ textboxes allow raw data flux (ADU) values to be rescaled. The default values are 0 and 1 respectively.

The ‘Apply to all’ button will copy the Y axis settings to all other loaded profiles.

The Normalise Flux button (to the right of the Data Multiplier) opens the Normalise Flux screen.

This tab provides three main options for scaling the Y-Axis.

2.4.3.1 Automatic scaling

This will automatically scale the profile to fit the range of intensity values (within the X-axis region) to the height of the chart.

Y Scaling % - The slider and textbox allow the magnitude of the profile to be increased or decreased (i.e. enlarge or reduce the profile). Press Enter after editing the textbox to apply.

Y Offset % - The slider and textbox allow the vertical position of the profile to be increased or decreased (i.e. move the profile up or down). Press Enter after editing the textbox to apply.

The Y Scaling and Y Offset (and associated textboxes) are only enabled when the Automatic scaling option is chosen.
2.4.3.2 Manual scaling

Scaling will be set using the minimum and maximum (ADU) flux values into the textboxes provided. Ensure you enter valid flux values otherwise the profile may not be shown.

The textboxes are only enabled if the Manual Scaling option is chosen.

2.4.3.3 Scale to first profile

The profile will use the same the minimum and maximum flux scaling values as the first profile. This is useful to compare spectra taken on several sessions with the same camera settings.

2.4.4 Calibration tab

This screen provides various options for selecting which calibration option to use. For details of creating a calibration see the Wavelength Calibration section.

The choice of calibration option (the radio button selected) is saved at a project level (i.e. you need to save the project).
No Calibration – Radio button allows calibration to be turned off. This can remain off when processing a DAT profile that is already calibrated at the source.

Use Calibration from First Profile – Radio button allows the profile to temporarily inherit the calibration of the first profile.

This is useful for when multiple profiles having the same calibration or dispersion are added to a chart. This is the default option when uncalibrated profiles are opened when the first profile is calibrated.

Profiles having the same dispersion (but differing offsets) can be manually aligned by setting the Image Strip View to ‘Raw Image’ or ‘Synth Binned (raw)’ and moving the image strips horizontally using the mouse while holding the Shift key.

Aligning or sliding the images will have no effect on the chart unless the Use Calibration from First Profile option is selected.

The “Copy” button has been provided to copy the calibration dispersion from the first profile and incorporate any offset from manual alignment of the image strips. Press Save to store the calibration. Once the calibration has been copied, the first profile can be removed.

Use Individual Calibration – Radio button to use calibration derived using this application.

The Coefficients textbox allows advanced users to read & access the polynomial calibration terms. Clearing the text box will remove calibration. The coefficients are saved in the BASS image information(.info.bas) file.

The “Calibrate” button will launch calibration mode. This will start a new calibration or edit an existing calibration.

Use FITS Header values – For FITS images only. Radio button to use the calibration values held in the FITS Header (in CRVAL1 & CDELT1 values). This currently supports linear FITS calibration tags only.

The read only textbox shows the values from the FITS header.

The BeSS settings screen can be used to populate the FITS header calibration values.

Lambda Offset – Textbox allows a manual shift of calibration by the specified negative or positive offset in nm.

Note: Changing calibration settings can have adverse effects if the profile has instrument response settings (because response curves depend on wavelength).
2.4.5 Correction tab

The Correction tab provides a choice of options for managing instrument and continuum corrections.

The choice of correction option (the radio button selected) is saved at a project level since this can be project specific. You need to save the project to store this setting.

The values in the text boxes are saved in the BASS image information file (.info.bas) file.

Note: Correction settings are only valid for the calibration setting used when they were created. Corrections can give erratic results if the calibration is removed or altered.

No Correction – Radio button allows existing correction to be turned off. This can remain off when processing a profile that has already had correction applied at the source.

This is the default setting when a profile is added to a project. Remember to select one of the options below if correction needs to be applied, or save as a project to automatically apply correction when next loaded.

Response File – Radio button allows the correction to be loaded from a response profile DAT file (created by BASS or other software). The adjacent browse offers a windows file dialog to help locate the file.

If you want to use an instrument response file in FITS format, select ‘No Instrument Correction’ and divide your profile with your response file to obtain a new corrected profile.
Instrument Correction – Radio button allows the profile to use the correction points created in the Continuum & Response Shaper screen.

The Points text box provides access to the data points that make up the response correction.

Continuum Removal - Radio button allows the profile to use the correction created in the Continuum & Response Shaper screen.

The Points text box provides access to the data points that make up the response correction.

Master ResponseCurves.dat file – Radio button allows the profile to select a response correction from the dropdown list.

Named profiles are generated by the Continuum & Response Shaper screen and are stored in the \Instruments\ResponseCurves.dat file, which can be edited via the Edit button next to the dropdown list.

The text file is in comma-separated format. The first column is the name of the correction, the remainder being the data points. Editing should be limited to renaming the first column and/or removing unwanted rows (to minimise the risk of corrupting the data points).

Note: To simultaneously display the uncorrected, corrected, and normalised versions of a single profile, load the same profile three times and set each to a different correction option.

2.5 Image Strips
The area between the tool bar and the chart will display the image strips loaded, including reference spectra (but not Planck curves).

Double clicking on an image strip will open the associated profile properties

Right mouse clicking on an image strip will provide a popup menu allowing access to many other functions.

### 2.5.1 Image Strip View type selection

The image strips work in conjunction with the Image Strip View dropdown list available on the toolbar.

There are five Image Strip View options:

**Raw Image**

Shows the raw images in actual size

![Raw Image](image)

**Note: Reference spectra and generated profiles are shown extended to the image strip height setting (in the Chart Properties screen).**

Selecting the Raw Image option also enables the main Image menu and sub menus. See the Image processing menu section for details.

**Synth Binned (raw)**

Shows grey binned (average of vertical pixels) image in actual image width.

![Synth Binned (raw)](image)

**Synth Colour (raw)**

Shows false colour binned (average of vertical pixels) image in actual image width.

![Synth Colour (raw)](image)

**Note – the displayed colours will be meaningless if the chart is not calibrated**

**Synth Binned (stretch)**
Shows grey binned (average of vertical pixels) image stretched to the width of the chart.

Synth Colour (stretch)

Shows false binned (average of vertical pixels) image stretched to the width of the chart.

**Note – the displayed colours will be meaningless if the chart is not calibrated**

The stretch options are the most useful for final presentation since the chart and image lines will be synchronised. The other options are useful for alignment and/or checking if things are as expected.

Double clicking on an image strip will show the associated properties for the profile.

### 2.5.2 Context Sensitive Image Strip Menu

Right mouse clicking on an image strip will show a popup menu with options for the associated profile.

- **Profile #** - The first item is not a menu, but displays the profile sequence number of the selected profile
- **Save Image As** – Opens a Save File dialog to save the selected image

- **Export to Profile**– Opens a Save File dialog to export the active profile data to either a FITS or DAT image format. The saved export is NOT part of the project (as it is a subset of original image).

  A DAT profile is a space + tab delimited text file format that is compatible with other spectroscopy applications

  The range of values exported is controlled by the current x-crop selections and/or the min/max wavelength chart setting.

  When a FITS is exported, calibration is inherited from the original image. If a multiple order polynomial was used then this is saved as an equivalent linear calibration over the selected x-axis range.

  The values exported will be as displayed in the chart including correction, where specified.

  **Note:** A “dat” file will contain wavelength (in Angstroms = nm x 10) and intensity paired values (or 0 & intensity if the profile is not calibrated).

  **Example format of DAT file extract:**

  | 4325.4407 | 11743.73 |
  | 4332.8543 | 10056.55 |
  | 4340.2679 | 8893.577 |
  | 4347.6813 | 9135.525 |
  | 4355.0949 | 9979.699 |
  | 4362.5082 | 10827.8 |
  | 4369.9216 | 11509.74 |
  | 4377.3352 | 11939.33 |
  | 4384.7485 | 12158.03 |
  | 4392.1619 | 12361.97 |

- **Hide Profile from Chart** – toggle visibility of the profile in the chart. When ‘hidden’ the profile display properties are set to ‘Line Width=0’ and ‘No Marker’. When ‘unhidden’ then ‘Line Width=1’

- **Remove Image** – the icon prompts to remove the current selected image strip and associated profile
• **Nudge left 1 pixel** – Slides the selected image strip by a single pixel for alignment purposes (see next section). This is disabled for the stretch image strip options.

• **Nudge right 1 pixel** – as per Nudge left but in the other direction.

• **Profile Properties** – Open the Profile Properties screen for the selected profile.

2.5.3 Manual Alignment of profiles

The image strips can be slid in the horizontal direction for manually alignment purposes when the shift button is held down. Image strips can also be slid using the Nudge left/right option by right clicking on an image strip.

Sliding image strips is applicable to the following scenarios:

- Alignment of a number of profiles prior to stacking
- Alignment of common features for profiles that have the same spectral dispersion
- Alignment of a profile with a calibration profile.

The manual alignment can be used in conjunction with the “Use Calibration From First Profile’ option (in Calibration tab of the Profile Properties screen) to calibrate one profile from another having the same dispersion but a different offset.

Manual alignment can be reset (removed) by clicking the Reset button in the Stack and Align Profiles screen.

**Note 1:** Manual alignment is only allowed when one of the first 3 options on the Image View dropdown list is selected. I.e. no alignment is allowed when in ‘stretch’ modes.

**Note 2:** Alignment is limited to single pixels only. It is possible to improve the accuracy of alignment by first resampling images to a larger number of pixels.

2.5.4 Identification of image strips

Hovering the mouse over an image strip will show the sequence number, caption and file path of the image underneath.
2.6 Selection menu

The Selection menu is only enabled when a 2 dimensional image is selected and the Image Strip View dropdown list is set to Raw Image.

2.6.1 Selection regions

The following options act upon on the rectangular area selected using the mouse on the current image

- **Crop to selection** – crops the image to the current selection. The cropped image can be saved using the ‘Save Image As’ menu

- **Set active binned region** – Binning will average only pixels within the height of the selected region

- **Set background region 1** – Defines the height of background region 1 to be subtracted from the active binned region

- **Set background region 2** – Defines the height of background region 2 to be subtracted from the active binned region

- **Set Exclusion region** - This defines a region, shown using light blue lines, where rows will be ignored from binning. This may be useful to exclude target spectrum contamination from a reference spectrum. In this scenario the exclusion region would sit inside the active binned region.

- **Clear selections** – clears the active, excluded & binned selections/regions (and renders the profile using an average of pixels over total image height)

**Region Selection Tool** - Opens the Region Selection Tool screen (see below) for fine adjustment of a selected area on an image.

Any individual region no longer required can be removed using the Region Selection Tool.

Changes to regions will take effect when the chart is refreshed (F5 or Refresh button).
2.6.2 Region Selection Tool

This screen is accessed from the Selection menu and allows finer control of the binning and background regions than using a mouse. It also allows individual regions to be removed.

The screen provides the following features:

- **Profile** - This is a read only text box that displays the active profile that changes will be applied to.

- **Region Type** – A dropdown list allowing the type of region. Changing the Region Type will update the X and Y values. The Generic Selection is useful for accurately setting an area prior to image cropping.

- **X Start** – First X pixel of area.

- **X End** – Last X pixel of area.

- **Y Start** – First Y pixel of area.

- **Y End** – Last Y pixel of area.

- **Width** – a read only field calculated by X End minus X Start.

- **Height** – a read only field calculated by Y End minus Y Start.

- **Statistics Area** - A read only selectable text box that displays the flux statistics of the current area defined by the X and Y values.

- **Reset** – A button that removes values for the selected Region Type.

- **Save** - The current area defined by X and Y values is saved for the selected Region Type.
• **Close** – Closes the screen

The best way to use this screen is to select a Region Type before adjusting the X and Y values.

The X and Y values can set using the up/down arrow keys and/or making a selection on the active image.

The Active, Subtraction and Exclusion region types will span the full width. Therefore X Start and X End will be read only and set to 0 and full width respectively.

### 2.7 Image processing menu

The image processing functionality is for FITS image formats and is available under the main ‘Image’ menu. Sub menu items under the Image menu are enabled or disabled depending on the Image Strip View dropdown list setting and whether the current image is a 2 dimensional image, (or a 1 dimensional profile).

#### 2.7.1 Image Profile number & caption

The first menu item is not an active menu; it just displays the sequence number and caption of the active image.

#### 2.7.2 FITS Header

This opens the FITS Header screen. (This is also available via the General tab of the Profile Properties screen).

This screen allows the FITS header values to be examined and modified.

The Enable Edit checkbox allows changes to be made, but displays a warning message.

---

**Warning - Don't make any changes to the FITS values unless you have a backup of your file and have a good understanding of how FITS keywords should be formatted!**
A right mouse click menu allows access to copy, edit, delete & insert options.

2.7.1 BeSS Settings
This opens the BeSS Settings screen

2.7.2 Save Image As
Prompts for file name to save the active image

2.7.1 Save As 1D

The Save As 1D screen can be accessed from the toolbar, File menu and by right mouse clicking on an image strip.
The purpose of this screen is to create a one-dimensional profile from a two-dimensional image.

The detailed functionality is listed below:

- FITS Header values are copied from source to target image where applicable.
- The filename to save the new 1D profile is prepopulated with a default using a "_1D" suffix.
- Automatically populates the FITS header with a linear calibration if the source was calibrated.
- If the source image used a polynomial calibration, the profile is resampled using a default sampling interval based on the highest dispersion value within the specified wavelength range. A manual override checkbox to specify your own interval is also provided.
- Calibration keyword values within FITS header will be saved in Angstrom unit by default.
- The screen has an option to display the 1D profile in the project, (saving the effort of having to browse and open it).

2.7.2 Hot Pixel removal

The Hot Pixel removal screen allows hot pixels (present in the majority of CCD or DSLR images) to be removed. The menu option is enabled for 2D images only.

Hot pixel removal must be prior to any processing that alters the position of pixels, (e.g. cropping, rotation, slant or tilt correction). The technique relies on the fact that the hot pixels on a spectral image will be in the same location as taken on a “dark” image. The hot pixels are identified by analysis of a dark image. The information can then be saved to a cosmetic file that can be reused on a number of images taken with the same camera (plus temperature and exposure time). It is also possible to remove hot pixels without a cosmetic file.
The basic hot pixel removal process is as follows:

- Ensure the Image Strip View is set to “Raw Image”
- Load image spectra into a new BASS Project session.
- Click on the top image loaded
- Click on the Image -> Hot Pixel removal menus to open the Hot Pixel screen
- Click on the open dark file icon and load your dark image.
- Ensure the tab on top of the screen is on “Dark Image”
- Adjust the threshold slider to detect hot pixels. Detected pixels are highlighted using a very small green x. Fine tune the threshold using the left and right keys
Hot pixels highlighted in dark image

- To save a cosmetic file, click the Save icon in the Cosmetic file panel. Enter filename and select *.lst or *.txt file type.

- When a cosmetic file has been created, or loaded from a saved file, the tab on top of the screen will switch to “Cosmetic file”.

- If you wish to apply the hot pixel removal to all the open images then click on the “Apply to all open images check box”

- Click on the Apply button

**Note: the cosmetic file steps can be omitted, i.e. you can apply the hot pixel removal once the threshold has been set.**

To remove hot pixels using a saved cosmetic file

- Open the Hot Pixel removal screen

- Click on the Open icon in the Cosmetic File panel and select a file

- Click the Apply to all open images checkbox (if appropriate)

- Click on the Apply button
2.7.2.1 Hot Pixel region

Region checkbox – Allows the detection of hot pixels to be restricted to an area selected using the mouse.

L + R Only checkbox – Use this to replace hot pixel values with pixels to the left and right only, (as opposed to neighbours in 8 directions). Useful for when a troublesome hot pixel is on an edge.
2.7.3 Black and white levels

This allows the FITS black and white levels to be adjusted. This will alter the appearance of the raw image, (but won't affect the profile chart since this is automatically scaled).

The levels are stored to the CBlack & CWhite FITS header values when the image is saved, to be re-instated when the image is next loaded.

The black and white levels can be set using the textboxes and/or sliders provided.

The Show Clipping checkbox is used to show pixels have have been clipped beyond the limits.

The CWhite/CBlack checkbox will set levels using CBlack & CWhite FITS header values where they exist.

The Auto Stretch button sets the levels based on the min and max detected values.

2.7.1 Horizontal Flip

A spectral profile should be displayed such that shorter (blue) wavelengths are on the left and longer (red) wavelengths are on the right. This function will flip the image as required.

To flip multiple images simultaneously, see the Bulk Image Manipulation screen section

2.7.2 Rotate/Tilt image

This allows an image to be rotated or tilted in order to correct for when the spectrum dispersion direction is not horizontal relative to the camera sensor. Enabled for 2D images only.
Refer to Appendix C – Rotate/Tilt/Smile/Slant correction for how to identify the different types of corrections.

**Note:** Care should be taken to align the spectrum with the camera axis in the first place to minimise the degree of rotation required. This allows the camera to capture the data with better resolution and prevents artefacts that can be caused by rotation.

The Rotate function is accessed from the Image menu (for a selected FITs image when the Image Strip View = Raw Image).

![Rotate/Tilt Interface](image)

**Correction Angle** – enter the angle in degrees, with negative numbers clockwise, positive numbers anticlockwise. You can also use the spin up/down arrows or arrow keys to alter the angle in 0.1 degree increments.

**Draw Angle** – use the mouse to draw a line corresponding to the rotation or tilt angle to populate the Correction Angle.

**Selection Option** – this panel offers the choice to rotate the image or apply tilt correction.

**Rotate Image** – select this option to rotate the image by the correction angle.

**Centre of Rotation** – leave the X and Y textboxes blank to rotate about the centre or specify the rotation point. This applies to rotation only. It has no effect on tilt.

**Tilt Image** – select this option to apply tilt correction by the correction angle.

**Apply** – this performs the rotation of the selected image (or all open images) using the angle and centre specified.

**Apply to all open images** – when this checkbox is ticked, the Apply button will apply the correction to all open images.

**Reset** – this button reverts the selected image to the previous (pre-rotated) state.

**Close** – closes the form.
Since the tilt angle will probably be unknown, it can be determined by trial and error by trying successive values and comparing with a rectangle selected around the spectrum.

![Spectrum before rotation](image1)

![Spectrum after rotation](image2)

**Note:** Rotation can sometimes create some invalid pixels in one or more corners. In this case you would have to crop the image to avoid auto-scaling issues.

![Before rotation](image3)

![After rotation (crop to yellow box)](image4)

### 2.7.3 Smile & Slant Correction

This allows a FITS image to be corrected for distortions where the spectral lines are curved or slanted relative to the axis of the spectrum. Enabled for 2D images only.

Smile is a curved distortion caused by misalignment within the optical configuration, (especially in Littrow spectrographs) and/or lens aberrations.

Slant is a distortion where the absorption lines are straight but are not perpendicular to the axis of the spectrum, (this differs from “tilt” where the spectrum direction is not aligned with the camera axis). Slant can also be created by trailing effects when using a slit-less configuration.

#### 2.7.3.1 Automatic Smile & Slant Correction
The automatic option will scan a selected region for pixels having the minimum (or maximum) intensities to determine the correction required.

The correction process is as follows (thanks to Jack Martin for use of the example image).

1. Open the FITS image to be corrected, ensure the Image Strip View is Raw Image.
2. If necessary, rotate and or crop the image to remove any tilt.
3. Click the image to select it.
4. Open the Smile and Slant corrector screen form the main Image menu.
5. Using the mouse, select a rectangle around the most defined line. (If an emission line is selected change the ‘Dark or Light line’ dropdown list accordingly).
6. Set ‘Pixels to Average’ at 3, leave Apply Best Fit as [none].
7. Press the Try button. This will draw a yellow curve that tracks the darkest (or brightest) pixels.
8. If the yellow curve is broken experiment with the Average or select a better area on the image.
9. Select an ‘Apply Best Fit’ option to draw a red line or smooth curve.
10. When the red line or curve looks good, press the Apply button to correct the selected image.
11. If the correction is not right, press the Reset button and repeat the process.
12. Only press the Close button when the correction is complete, or press the Reset button first if you wish to abort the correction.

Calibration should be performed after any tilt, smile or slant correction (as the offset and dispersion will have been affected).
2.7.3.2 Manual Slant Correction

The manual option will allow the user to either enter or draw the slant angle. The image is then corrected so that the slant angle is made vertical. For clarification, 0 degrees corresponds to a horizontal line.

1. Open the image to be corrected

   ![Spectrum before slant removal](image)

2. Open the Smile and Slant corrector screen from the main Image menu.

3. Click on the Manual Slant tab header

4. Specify the slant angle

   If the slant angle is known
   - Select the Enter Slant Angle option
   - Key in the slant correction angle (in degrees) into the text box provided and press the Try button. (You can also change the angle using the spin up/down arrows or the arrow keys)

   If the slant angle is unknown
   - Select the Draw Slant Angle On Image option
   - Use the mouse to draw a box around the feature to use for correction and press the Try button
5. If necessary, edit the slant angle (by trial and error) and press the Try button until the lines are vertical.

6. Only press the Close button when the correction is complete, or press the Reset button first if you wish to abort the correction.

2.7.1 Resize Image screen

This allows the selected image to be resized. Enabled for 2D images only.

The resizing can be done either a percentage basis (for both width and height), or by specifying new width and/or height values.

The Apply to all open images option applies the new width and height values to all images.

2.7.2 Normalise Flux Scale

The main use is for normalising the y-axis continuum value to "1".
The Normalisation Flux Scale screen (accessed from under the Image menu) has two tab headings.

- Normalise Continuum – Uses the average flux over a given wavelength range
- Advanced – Rescales the y-axis to a target value using upper and lower flux values.

2.7.2.1 Normalise Continuum tab

The Normalise Continuum tab will normalise the scale using the average value between the specified wavelength range.

The default range shown is taken from the Ranges tab of Chart Settings, but values can be overwritten if necessary.

Click Apply to normalise the flux intensity to 1.

Note that the average flux between the specified range is populated in the Upper + Raw text box in the Advanced tab.
2.7.2.2 Advanced tab

The Advanced tab provides an alternative method for flux normalisation based on taking a measurement.

Follow the instructions provided in the screen shots below.

If you want to normalise to a value other than “1”, overwrite “1” with your chosen value into Upper Normalised (New) textbox.
Press Reset to revert back to normal scaling.

2.7.3 Bulk Image Manipulation screen

This allows image processing and manipulation to be applied to multiple images. For example, all images can be flipped from left to right and be set to the same active and background regions, and/or black and white levels. This functionality is intended primarily for a small number of slit spectrometer images that don’t require alignment. Enabled for 2D images only.

Note: It is recommended that you are familiar with executing image processing on individual images before processing images in bulk. In addition, the processing applied to multiple images must be appropriate e.g. the images should be of the same target and configuration.

The screen contains the following features
• **Active and Background Regions** - ticking this checkbox will copy active and background region settings from the top image to all open images.

• **Black and White levels** – ticking this checkbox will apply the black and white levels from the top image to all open profiles.

• **Crop to Selection** – this will crop all open images using the current selected rectangle on the top image.

• **Flip Left to Right** – this will flip all open images from left to right (mirror image).

• **Save Images As** – this will save all images within the project with a new filename constructed using a prefix in front of the original filename.

  This is useful when you need to save separate copies of file, say that had been cropped and/or rotated etc. The project uses the new filenames.

  New images must be saved beforehand. Any prefixed filename that already exists will be overwritten without warning.

  *Note. Take care not to run multiple times as the filenames will also be prefixed multiple times and you will get more versions. If you need to redo, it may be better to close the project and reload the original images.*

• **Reset** – button to undo changes applied when Apply was pressed

• **Apply** – button to apply changes to all open images

• **Close** – close the screen

*Note that Crop to Selection cannot be used at the same time as Active and Background Regions. Crop the images before setting active and background regions.*

### 2.8 Stack Images

A Stack Images screen is provided to provide stacking and alignment of images to improve the signal to noise ratio. (Not to be confused with existing functionality for stacking and alignment of 1 dimensional profiles as per section).

The Stack Images screen is accessed via a toolbar icon.
2.8.1 File Menu

The File menu includes the following options.

This allows the list of files and settings to be saved and loaded. A default file extension of “*.stk” is used. The file format is tab delimited text.

2.8.2 Image Menu

The Image menu provides a Black & White Levels option

2.8.3 Zoom Menu

The Zoom menu is only enabled when an image in a list box is selected.
The zoom options allow the selected image to be viewed at a different scale.

2.8.4 Light Images

The first tab header allows the light images to be loaded for stacking.

To load images press the Folder button and select one or more files from a Windows file dialog.

Clicking on a file from a list box displays the image on the right.

Note – A globular cluster image is shown in this example, but the images could also be from a slit-less Star Analyser type grating or a slit spectrometer.

To remove images files, highlight one or more files in the list box and press the Remove button

Note – If the Shift key is held down when the Remove button is pressed then an option will appear allowing the actual files (and associated BASS image information file *.info.bas files) to be deleted.

Where possible, local files are moved to the PC Recycle Bin, (but will not be recoverable if the recycle bin is disabled, full or if the files are on a network drive).

Selecting each file item in the list in turn, allows a basic examination of each file with an end to rejecting lower quality images.
If necessary, use the black and white levels icon (next to the Stack button) to make images easier to view.

2.8.5 Image Alignment

An alignment option dropdown list is provided.

![Alignment Option Dropdown](image)

The options are:

- No alignment – images are stacked without any alignment. (Normal for slit-spectrometer spectral images).
- Align images – aligns images in horizontal and vertical directions. This is the default option.
- Align horizontal only* – images are only aligned in the horizontal direction
- Align vertical only* – images are only aligned in the vertical direction

* Experimental settings for spectral processing only

If alignment is required, select the first image in the list of light images and then select a rectangle around a feature to be used for alignment (the ‘Zero Order’ normally works well enough for a slit-less grating image). The selection should be of sufficient size to encompass the same feature in subsequent images. If this is not possible, because other brighter features would be picked up, then individual selections of the feature can be specified per image.

![Alignment Tool](image)

To remove alignment information, click the ‘Clear align points’ button.

**Note:** If alignment is necessary but cannot be achieved due to a lack of point features, then another possibility is to process frames individually and use the Stack and Align Profiles functionality under the Operations main menu.
If Dark, Bias, Flat and or Flat Dark images were taken, click on the second tab header and load (see next section).

2.8.6 Dark/Bias/Flat

The second tab header provides sections on left hand side to allow Dark, Bias, Flat and/or Flat Dark images to be loaded or removed. Selecting a file from a list box displays the image on the right.

To load files press the Folder button and select one or more from a Windows file dialog.

To remove files, highlight one or more files and press the Remove button

*Note – If the Shift key is held down when the remove button is pressed then an option will appear allowing the actual files (and associated *.info.bas files) to be deleted. Where possible, files are moved to the recycle bin (i.e. deleted but with the option to recover them).*

Files in the second tab are not mandatory. Where multiple files are provided, the system will generate a ‘master’ on the fly that has data combined by median or arithmetic mean (defined in the first tab header).

2.8.7 Stacking Process

Pressing the Stack button will initiate processing as follows:

1. Validate that one or more light images are loaded
2. Validate that an alignment region is set for at least the first image (only if align images is ticked)
3. Aggregate Dark images (if exist)
4. Aggregate Bias images (if exist)
5. Aggregate Flat images (if exist)
6. Aggregate Flat Dark images (if exist)
7. Each light image is then processed pixel by pixel to:
8. Subtract the master dark value (if exist)
9. Subtract the master bias value (if exist)
10. Divide by the master flat value minus the Flat Dark master value (if exist)
11. The pixel position is adjusted such that light/subs are stacked accordingly (if alignment enabled).
12. The result creates a new FITS image that is loaded into the main BASS Project chart for subsequent background removal, calibration etc. Set the Image Strip View to raw image to see the stacked result.
13. The FITS header keywords, DATE-OBS, DATE-END and EXPTIME, are populated to show the start and end date & times of image acquisition. EXPTIME shows the time in seconds, between the end of the last image and the start of the first (not the camera exposure time).

You can open the Stack Images screen again to review and restack if necessary. Notice that there will be yellow “+” at each detected alignment point.
Note: The Stacking mechanism is intended for spectroscopic use. It therefore does not provide astronomical image processing functionality such as curves and layering. In addition, there is an assumption that only a relatively small number of images will be stacked.

2.9 Stack and Align Profiles

Stacking profiles averages a set of one dimensional image profiles to create an average of the profiles, usually in order to improve the signal to noise ratio.

See also the Stack Images section to stack and align two dimensional images.

The Stack and Align profiles screen, accessible from the Operations menu, allows one dimensional profiles to be stacked, aligned or aligned and stacked.

Here is a high level process to align & stack multiple profiles

- Load multiple spectra (10 in this case). These were unguided so positions of spectral lines vary in each spectrum.

- Before aligning & stacking you would need to apply geometric (corrections if required) and the set the binning and background subtracted regions of each profile. This can be done using the Region Selection Tool and Bulk Image Manipulation screen functions.
• Open the Stack and Align screen from the Operation menu

• The Stack and Align screen provides a list box to allow individual profiles to be selected. All are selected by default. Remember to unselect any you don’t want to be included.

**NB it is recommended that you reopen this screen if profiles are added or removed while this screen is open, otherwise the list of profiles may not be up to date.**
• Tick the Align checkbox and then either manually key in or use the mouse on the chart to select a pixel range on the chart that covers the feature to be aligned. In this example we are using the Hydrogen Alpha peaks between 897 and 960 pixels.

• Tick the Stack and Highlight checkboxes.

• Press the OK button and then OK in the confirmation dialog box. The screen will close, profiles will be aligned and a new stacked profile #11 is created.
2.10 Crop X-Axis Range

This function is available from the toolbar or Chart menu and allows you to zoom in on a region by setting the start and end x-axis values. This is a very important feature since the chart will auto-scale the y-axis based on the x-axis range, (y-axis scaling can also be manually adjusted if necessary).

The three radio buttons offer the choice of cropping using wavelength, pixels and for cancelling crop to show the entire profile.

The wavelength radio button and min max boxes will only be available (enabled) when the top profile is calibrated.

![Crop X-Axis Range Dialog](image)

2.10.1 Zoom in

To crop (zoom in) on a region within the existing chart, first select the range using the mouse, holding down the left mouse button, before clicking on the Crop X-axis icon.

![Crop Example](image)

The min and max values are prepopulated using the range selected prior to clicking the icon. Once the screen is displayed, you can edit the text boxes if necessary, before clicking on OK or Apply.

The entire chart area is then filled with the cropped region.
You can continue to make selections and zoom in further.

The textboxes are validated to restrict inputs to the maximum or minimum allowed pixel or wavelength values. E.g. if the image is 1391 pixels wide and you try to enter 9999 then 1391 will be displayed.

2.10.2 Zoom out

To zoom out again either click on the Turn Off Cropping radio button, or specify wider min and max values.

2.11 Wavelength Calibration

Wavelength calibration (also known as spectral calibration) is the process to allow the profile to be presented using wavelength along the x-axis (rather than pixel). It normally involves identifying two or more features where the wavelength is known.

Note: BASS uses nanometers (nm) as the default unit of wavelength, but this can be changed to Angstroms or microns (in Chart Settings see 2.2.3). The conversion is 1nm = 10 Angstroms = 0.001microns

The functionality to calibrate a spectral profile is accessed by the main Calibration menu. Calibration data is saved to the “.info.bas” image information file that shadows the profile or image being calibrated. This is able to store multiple order calibrations as well as the actual calibration data points (which are not normally stored in FITS files).

The screen functionality is show in the annotated screen image below and described in subsequent sections.
2.11.1 New Calibration

The New Calibration function (available from the main Calibration menu) is used to calibrate a new image or to repeat the calibration on an already calibrated image.

If an existing calibration needs to be disabled, select the No Calibration option from the Calibration tab of the Profile Properties screen. If calibration data needs to be permanently removed, use the Remove Calibration option under the Calibration menu.

Any new image created, (e.g. by a maths operation or resampling), must be saved before it can be calibrated.

2.11.1.1 2 Point calibration

The simplest calibration needs just two reference points and uses a linear best fit line to calculate the wavelength at any pixel position.
Open an un-calibrated spectral image of a star having known absorption lines, then select New Calibration. The cursor and the status bar text will turn red to indicate calibration mode. Notice the red circle that will track the profile as the mouse is moved.

The next step is to identify features and record wavelengths against the features on the chart. There are two ways to identify the feature for calibration purposes:

- Select a range of pixels either side of the feature, or
- Double click on the minimum or maximum intensity of a feature.

In the following example, (of the star Vega), the zero order peak on the left will be used as the first calibration point.

**Selecting the calibration point using a range**

This is the default option (where the Shift key is NOT held down) and is recommended for most situations.

The LH status bar displays a prompt to Press Shift or Select a range either side of the calibration point number (starting from #1)

Click to the left of the first peak and while holding the left mouse button, drag the mouse to the other side of the peak. Releasing the mouse will show the location of the minimum or maximum peak and open the Calibration Reference Line dialog box. This dialog allows you to select from a list of common element lines or manually specify the wavelength. Enter 0 in the wavelength field or select the Zero Order option and press OK.
Selecting the calibration point using double click

When the Shift key is held down, the LH status bar displays a prompt to double click and the current calibration point (starting from #1). The cursor pixel position is also displayed.

While holding the Shift key, place the cursor in the centre of the zero order peak and double click. This opens the Calibration Reference Line dialog box allowing you to select from a list of common element lines or manually specify the wavelength. Enter 0 in the wavelength field or select the Zero Order option and press OK.

Once OK is pressed in the Calibration Reference Line dialog, the status bar will prompt for the Second calibration point. Identify the second reference line to open the Identify Calibration Reference Line dialog.
For this example, we select the Hydrogen Beta line as the second reference line. The dialog box can be moved if it obscures the area of interest.

Click on the Select element dropdown combo to select the element (Hydrogen in this case) and then select the Hydrogen Beta option from the reference wavelength combo underneath.
Press “Finish” to complete the 2 point calibration. The chart X-axis now displays wavelength in nm. The status bar (bottom left) will show the current wavelength when the cursor is moved across the chart.

The calibration lines are visible after a calibration is completed. Use the Show Calibration item under the main Calibration menu to toggle the lines on/off.

**Note:** Increasing the working size of the chart prior to calibration can allow a more accurate setting of calibration points when using the Double Click method. Chart size is set via the Edit Project Chart settings option under the main Chart menu.

**Note:** The calibration points and the calibration equation coefficients are saved into the profile’s “.info.bas” image information file. The calibration equation ‘coefficients’ are visible in the Calibration tab of the Profile Properties screen.

### 2.11.1.2 Single-point calibration

A single point calibration can be used when the linear dispersion is already accurately known.
First calibrate a feature on the chart where the wavelength is known, (Hydrogen Alpha in the example below).

Next press the ‘Finish 1Pt’ button and key in the dispersion factor (in your chosen wavelength unit per pixel) into the popup box provided.

2.11.1.3 Multiple-point calibration

A multiple point calibration uses three or more points to calculate a polynomial best fit curve that is used to translate pixel position to wavelength. The reader should be familiar with the techniques used in a 2-point calibration before proceeding.

The process is similar to the 2-point calibration except that the “Add Another Point” button is clicked when the second point is being set. The ‘Add Another’ button accepts the second wavelength and prompts you to identify the third wavelength. You can repeat the process to keep on adding more calibration points until the “Finish” button is clicked.
The functionality of the screen is shown below

Select element filter
A dropdown list containing a list of elements. The data is read from the LandaData.dat file in the \Reference sub-folder of the installation folder.

Element Sort
A dropdown list next to the element filter that changes the sort order of the element filter dropdown.

Enter Wavelength
A dropdown list that contains the list of element lines. These are filtered to a single element if a value is selected from the element filter.
**Data Grid**
Each calibration point is represented by a row in the read only data grid. The columns are described below.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>The sequence of the calibration points</td>
</tr>
<tr>
<td>Pixel</td>
<td>The pixel where the line was selected on the chart</td>
</tr>
<tr>
<td>Wavelength</td>
<td>The wavelength (in Angstrom, nm or micron) specified at the pixel. The cell value in the last row is synchronised with the value from the wavelength combo box.</td>
</tr>
<tr>
<td>Error</td>
<td>The difference between the calculated fit and the entered value</td>
</tr>
<tr>
<td>D (Delete Bin)</td>
<td>Clicking on the Bin icon will prompt to delete the calibration point</td>
</tr>
</tbody>
</table>

The Screen can be resized to show more rows if necessary

**Calibration fit dropdown list**
This offers a choice of the degree of polynomial required to calculate the fit. When 2 points are taken the only option will be for a linear fit. The list will offer 1-n items, where n is the number of points, but limited to a maximum of 10. The default choice will be a linear fit. Generally speaking, look for the lowest error values as you change the degree of polynomial.

**Hint:** Use the up and down arrow keys to change the degree of the polynomial as this allows you to see the error values as the degree changes without having to open and close the combo box.

**Calibration Data Export button**
The data export icon generates a tab delimited text file with an *.xls extension and prompts for a filename and path to save. Once saved, the user is prompted to launch file using the application associated with the saved file extension. This has been tested with Excel and OpenOffice.

The calibration data can be used for subsequent analysis using a spreadsheet/workbook. See Appendix A – Calibration Export data file for details of the file content.

**Total Error text box**
This read only text box shows the total error on the points entered. This is calculated as the square root of the sum of each error.

**Coefficients text box**
This read only text box shows the coefficients derived from the pixel and wavelength pairs of values. These are always in nm to maintain backwards compatibility when stored in *.info.bas files.

Each coefficient is separated with a comma. The number of coefficients depends on the degree of polynomial used. The first value is the offset.

For example a linear fit will have two terms, a and b, corresponding to the offset and slope \( f(x) = a + bx \)
Note: New and/or non-mathematical users need not be intimidated by ‘polynomials’ and ‘coefficients’. These values are fully managed within the application but are made available for advanced users.

2.11.2 Edit Calibration

An existing calibration can be edited for calibration points to be added (or removed) and/or the degree of polynomial regression to be changed.

With a calibrated profile loaded, select the Edit Calibration item from the main calibration menu. This opens the ‘Calibration Reference Line’ dialog in the state that it was previously in, just before the calibration was completed.

The options available are:
- Edit the wavelength of the last calibration point
- Press Add Another Point to add more calibration points
- Delete one or more rows from the grid
- Edit values in pixel or wavelength columns (double click or press F2)
- Change the Calibration fit (degree of polynomial)
- Export calibration data for analysis

When a calibration edit is in progress the existing calibration and instrument response are disabled so the profile returns to its raw state. This will revert back if the calibration is cancelled.

2.11.1 Remove Calibration

This menu option will prompt for calibration data, (data points and polynomial coefficients), to be removed from the selected profile. Calibration data in the *.info.bas file will also be blanked.

Note: This only removes calibration from profiles calibrated within this application. This will not affect DAT files where wavelength is already stored as the first field within a profile. It will also not remove any calibration held within a FITS header (these can be blanked out using the BeSS Settings screen)

2.11.2 Show Calibration Points

The menu option will toggle the display the calibration points (of the top profile).
Each calibration label shows the following:

- ‘cal’ + sequence number that the point was added
- Wavelength (in Angstrom, nm or micron)
- Pixel Position

Calibration lines and labels are always shown in red.

### 2.11.3 Using Reference lamps

A reference lamp can be used to provide the reference wavelengths for calibration.

- The reference lamp spectrum should be positioned at the top image strip (sequence number 01)
- Apply tilt, smile and slant corrections as required.
- Using one of the methods detailed above, select the known line(s) and, from the drop down list (i.e. Neon) and select the wavelength.

The calibration calculated will be applied to all other spectra in the project file.

### 2.12 Measurements & Elements screen

The Measurements & Elements screen, (accessed via the toolbar icon or main Tools menu), can be used display measurements and statistics based on a range selected on the active profile. This screen also allows lines from elements to be added to the chart.

The screen is divided up into 3 tab header sections:

- Elements Lines
- Measurement Options
- Measurement Results
To take a ‘measurement’, select a range on the chart (after the Measurements & Elements screen is opened).

2.12.1 Element Lines tab

The Element Lines tab is displayed by default when the screen is invoked with a calibrated chart. This functionality is not available unless the chart is calibrated.

When a measurement is taken, the application will search for the min or max wavelength against a list of element lines. The closest match, within a specified tolerance, is highlighted in the list box. If one of the ‘Show Element lines’ options is selected, then a line is added to the chart. See caveat* below.

Data Source

The default data source for the element lines is currently maintained in the small text file, LambdaData.dat, found in the \Reference folder under the installation path (the same file is used for calibration). This file contains only the common element lines (based mainly on the Solar Fraunhofer lines)

Note: Alternative data source files can be used so long as they are placed in the same location and are in the same comma separated format with the following fields
- Element Name
- Element Symbol
- Wavelength (in Angstrom, nm or micron)

Caveat* – It is important to understand that the tool to identify a single element line is extremely sensitive to calibration errors so should be used with caution. Results can be very useful with a small data source file, but can be difficult when used with a large data source. This is because there can be hundreds of possible element matches even within a small tolerance.
Element Lines List box

The Elements Lines list box shows the element lines from the data source and element filter selections.

Element Filter

The element filter dropdown list offers a selection of elements that are contained in the data source file. [none] will search across all elements in the file.

The filter selection will update the element lines in the element lines list box.

Tolerance

The Tolerance dropdown list determines how precise the match needs to be. This will depend on many factors including the spectrometer configuration.

Colour

The Colour picker allows choice of the colour for element lines subsequently added.

Element display options

The Element display options dropdown list performs two functions:

- Determines if and how a matching element will be displayed on the chart after a measurement
- Allows the user to manually add element lines (independently of the measurement).

The dropdown list provides 3 options

- Don’t show element lines – no element lines are added to the chart.
- Show element lines only – a dotted line without text is displayed
- Show element lines + text – a dotted line plus element symbol and wavelength are displayed.

Clear Lines

This button will remove all element lines from the chart.

Note: No functionality is provided to manage individual element lines. To make changes to the element lines displayed first remove all and then add again.

2.12.2 Manually adding element lines.

This allows known spectral lines of elements to be superimposed onto a chart (in order to see if they correspond with unknown lines from your spectrum).

This is best illustrated with an example to display all the Hydrogen lines onto a chart.

With the Measurements & Elements screen displayed:
• Select LambdaData.Dat as the data source

• Select Hydrogen from the Element Filter

• Click the top row in the Element Lines list box. While holding the shift button, scroll to the bottom to highlight all the Hydrogen rows.

• Select the ‘Show element lines + text’ (or ‘Show element lines only’) option from the Element Display options dropdown list.

2.12.3 Measurements Options

This tab determines which measurements & statistics will be displayed in the Measurement Results tab when a measurement is taken.

There are two ways to take a measurement:

• Select an region on the chart using the mouse (click and hold left mouse button to start, drag to the end and then release)

• Key in ‘From’ and ‘to’ measurement range and press the Run button
Result Options - Check boxes are provided to return the following, when ticked:

• Selection Details
  o Selected start, end & width in pixels, wavelength if calibrated and velocity if the X-axis is in Doppler Shift mode).

• Min, Max & Average
  o Max and Min Flux - and the corresponding pixels, (wavelengths if calibrated and velocities if the X-axis is in Doppler Shift mode)
  o Flux Range (Max – Min intensity)
  o Average Flux –RMS Intensity (as root mean square of the 1-dimensional profile intensity)
  o Average and root mean square (RMS) flux values
  o Standard Deviation
  o Signal to Noise Ratio (SNR)

  Note: Doppler Shift mode is enabled via the X-axis tab of the Project Properties screen.

• Continuum Slope
  o Slope of the intensity continuum from selection start to end. Displays ADU/nm (where calibrated) and ADU/pixel

• Equivalent Width
  o Profile Area (area under line)
  o Line Area (area excluding continuum). Also shown as percent of profile area
  o Continuum Area. The area of line between start and end points and zero flux
  o Equivalent Width (EW)

  EW is a measure of the area of the line on a plot of intensity versus wavelength and provides an indication of the power of the line.
The EW area is shown as a hatched rectangle and is not indicative unless the chart y-axis starts at zero or less and the rectangle fits within the x-axis bounds.

For emission lines, the EW will be negative.

- FWHM
  - Full width half maximum in chosen wavelength unit (or pixels if not calibrated). This uses a graphical calculation method (to distinguish from a Gaussian fit method).
  - If calibrated, the calculated R (resolving power) is also displayed. Note the R value assumes the measured line is from a reference lamp or similar. Since this value is mostly used for indicative purposes, it will be rounded to the nearest whole value.
The unit for all intensity measurements will be ADU.

**Measurement Range** - The ‘from’ and ‘to’ text boxes are populated when a measurement is taken using a mouse selection. Values can also be keyed in to allow repeatable measurements.

Units are Angstrom, nm or micron, (or pixel if chart is not calibrated)

**Number Format** – A drop down list to choose the number of decimal places for measurement results to be displayed. Results are formatted using this setting after calculations have been made using unrounded values. The blank dropdown list value will display unrounded values.

**Interval** – The number of slices between pixels for interpolation and area calculations. Lower values can speed processing, but with possibly less accuracy. Default value =20

**Show Results when run** – A checkbox that switches to the Measurement Results tab when Run is clicked.

**Run** – A button to take a measurement

### 2.12.1 Measurements Results

The measurement results tab is a multi-line read-only text area that contains the results specified in the Measurement options tab.

Unless otherwise specified, results are initially calculated using raw values and then formatted to the number of decimal spaces specified in the Measurement Options tab. This means that some calculated results may not always reconcile with calculations made using already rounded values.

Use the scrollbar or resize the screen to see all the displayed results.
Data can be copied from the text area (for subsequent pasting elsewhere) using the mouse.

**Note**: The reported measurements will use cubic spline interpolation and may therefore differ slightly from the figures shown on the left hand status bar (that use linear interpolation).

2.13 Reference Spectrum

The Reference Spectrum screen is available from the toolbar or the main Tools menu.

The screen will display a corrected reference spectrum, (originating from the Pickles library from https://www.eso.org/sci/facilities/paranal/instruments/isaac/tools/lib/index.html), which can be added to a chart. A Reference spectrum is commonly used to derive a corrected instrument response.

2.13.1 Selecting a reference spectrum

Select the spectral class appropriate for your image from the list on the LH panel on the screen. (For example select A0v for a Vega image or K5iii for Aldebaran). The list is in order with the highest temperature ‘o’ and ‘b’ stars first.

Once a class has been selected, the screen will display a binned image view and preview a chart from 300 nm to 1000 nm. Move the mouse over the chart to display the wavelength of a feature.

The list of spectral classes displayed can be filtered by keying into the “Filter List” text box on the bottom LH corner. Clear the textbox to show the complete list.

2.13.2 Adding reference spectra to the project

Once a stellar class has been selected, click on the Add Spectrum to Chart button on the bottom of the screen. This will add the reference spectrum to the main chart as
an additional profile. Multiple reference spectra can be added to the main chart, if so desired.

Click the Close button to close the screen.

Note: The spectra provided originate from the Pickles library and not all classes have spectra provided. An intermediate spectral class can be obtained by selecting two references and averaging them i.e. an A2i and A2v can be stacked to provide a usable A2iii reference spectrum.

The reference spectra files provided are held in the …\Reference\Spectra folder underneath the installation folder.

Reference spectra from other sources (e.g. from MILES) can be added to the project as per the normal add image process.

2.14 Continuum & Response Shaper

The purpose of this function is to create a response correction from points double clicked on the chart. This is available via the main Tools menu or toolbar icon.

There are two main types of corrections that can be created and stored against spectral profiles:

- Instrument Response correction – This is normally created by dividing a raw profile with a reference profile and smoothing the result. Profiles need to have been calibrated before an instrument response is carried out.

- Continuum Removal – This is also known as normalisation and is created by dividing the raw profile with a smoothed version of itself.

There are many ways of managing the correction data. You can save the correction as a separate response DAT file (as traditionally used by many other applications), or save as a set of cubic spline points (either within the profile’s image information *.info.as, or centrally within a master ResponseCurves.dat file).
More details are provided in the “Save Curve Options” sub heading.

2.14.1 Instrument Response creation process

This process will save the correction as a set of cubic spline points that are stored with the profile (in the*.info.bas file).

- Load a calibrated but uncorrected profile (or disable existing correction).
- Add the reference spectrum that the profile belongs to.

- Divide the profile by the appropriate reference spectrum (e.g. divide a Vega profile by A0v).
- Open the Continuum & Response Shaper screen, the colour of the cursor and status bar text becomes orange to indicate the chart is in ‘continuum shaper mode’.
- Move the Continuum & Response Shaper screen so that the divided profile is not obscured
- Click on the image strip of the divided profile to make it the active profile.

- Starting from the left, double click on points along the divided profile that fall on a smooth curve that avoids sharp peaks & troughs. As the cursor tracks the intensity, you just need to move along the x axis. Double click on an existing point again to remove it.

- Tick the Free Draw check box to allow points not on the intensity profile to be added.

- Click Refresh to clean up the curve if necessary.

- Once you are happy with the curve, press the Save button and select the ‘Save as Instrument Response) for: ’ option.

The results of the instrument response correction are visible once selected in Profile Properties.
2.14.2 Continuum Removal process

- Load a calibrated but uncorrected profile (or disable existing correction)
- Open the Continuum & Response Shaper screen
- Move the Continuum & Response Shaper screen so that the profile is not obscured
- Starting from the left, double click on points along the profile that fall on a smooth curve that avoids sharp peaks & troughs. As the cursor tracks the intensity, you just need to move along the x axis. Double click on an existing point again to remove it.
- Tick the Free Draw check box to allow points not on the intensity profile to be added
- Click Refresh to clean up the curve if necessary
- Once you are happy with the curve, click the Save button and select the ‘Save as Continuum Removal for:’ option.
As per the screenshot below, the continuum correction curve and points double clicked are shown in orange.

The results of the Continuum Removal or Instrument Correction are visible once selected in the Correction tab of the Profile Properties screen.
Click Apply to see the profile with the continuum removed. If necessary, adjust the x axis crop range to remove spurious results at the extreme ends of the profile.

2.14.3 Save Curve options

When the Save button is pressed, four options are offered:

- **Save as Response DAT file** – This is the ‘traditional’ option and will prompt for a file name to save the correction curve as a DAT profile that can be then linked to the profile or even used for other applications.


To apply this correction, select the Response File option from the Correction tab of the Profile Properties screen, then browse or enter the file & path of the response file.
- **Save as Instrument Response for profile <profile name>** – Select an open profile from the dropdown list. Press this button to store points in the profile’s "info.bas image information file. This will prompt to overwrite if a correction exists.

  To apply this correction, select the Instrument Correction radio button from the Correction tab of the Profile Properties screen.

- **Save as Continuum Removal for profile <profile name>** - Select an open profile from the dropdown list. Press this button to store points in the profile’s info.bas image information file. This will prompt to overwrite if a correction exists.

  To use this correction, select the Continuum Removal radio button from the Correction tab of the Profile Properties screen.
- Save to Master ResponseCurves.dat file - This will prompt for a response curves name and then append the points to a new line at the end of the master response curves data file (ResponseCurves.dat). This makes it easy to be reused for other profiles.

To apply a response curve from ResponseCurves.dat to a profile, select the 'Master ResponseCurves.dat' radio button from the Correction tab of the Profile Properties screen and then select from the dropdown list.
The contents of the points text box are available to cut/paste into your own text files if you so wish.

**Note:** When a response correction is saved to the profile, it is not applied immediately to the chart. To apply the correction, use the Correction tab of the Profile Properties screen.

**Note:** To redo a response correction, first turn off any existing correction by selecting the ‘No Response’ option in the Correction Tab of the Profile Properties screen.

### 2.15 Planck Temperature Curve

The Planck temperature tool is available via the main Tools menu or toolbar.

The classification of a star depends not only on the size and elemental composition, but also the surface temperature. The Plank Curve displays the distribution of irradiance with wavelength and shows that the peak wavelength is determined by the surface temperature. The shape of the continuum of a stellar profile is governed primarily by its temperature as if it was a “black body”.

The screen contains the following features:

- **Temperature textbox** – Generates a Planck curve for the temperature entered (degrees Kelvin)
- **Wavelength textbox** – Generates a Planck curve for the peak wavelength entered (Angstrom, nanometres or micron)
- **Temperature slider** – Provides an alternative method to set the temperature (& peak wavelength)
- **Height textbox** – Specifies the height of the Planck curve peak drawn on the chart. This makes the curve larger or smaller. 100% will fit to the height of the chart.
- **Height slider** - Provides an alternative method to set the height.
- **Offset textbox** – Specifies the vertical position of the Planck curve drawn on the chart. This moves the Planck curve up or down.
- **Offset slider** - Provides an alternative method to set the offset.
- **Line Width dropdown list** – Allows the thickness of the line to be set. A ‘0’ value will hide the line.
- **Colour icon** – The icon opens a Windows Colour picker dialog allowing the display colour of the Planck curve to be changed.
- **Previous button** – This navigates to the previous Planck curve (when applicable). The form caption displays the position of the current item in relation to the number of Planck curves (e.g. item 2 of 3 total)
- **Delete button** – This prompts for confirmation before removing the current Planck curve.
• **Next button** – This navigates to the next Planck curve (when applicable). The form caption displays the position of the current item in relation to the number of Planck curves (e.g. item 2 of 3 total)

• **Export button** – This prompts for a filename to save the active Planck curve as a DAT profile. Having the Planck curve available as a profile allows operations such as division to be performed.

• **Save button** – This adds the Planck curve to the chart; otherwise the curve will be removed when the chart is next redrawn.

• **Close button** – Closes the screen.

2.15.1 Relationship of temperature and peak wavelength

The temperature and peak wavelength textbox values are related as below

$$\lambda_{\text{max}} = \frac{2897820}{T}$$

Where $T$ is the temperature in degrees Kelvin and $\lambda_{\text{max}}$ is the peak wavelength in nanometres.

E.g. Typing in 400 nm as the wavelength will update the Temperature value to 7244.6K (and vice-versa).

2.15.2 Fitting the Planck curve

The Height and Offset textboxes and horizontal sliders are provided to help match the amplitude and level of the Planck curve with your spectral profile. If you need more movement than the slider allows, just enter the number in the textbox.
The process can be repeated with different stellar classes. Matching the Plank curve gets more difficult with blue stars as the peak wavelength is beyond the useful response. The trick is then to try to match on the shape of the descending curve.

Editing the temperature field until a best match is found is a technique that can be used to help determine the temperature of an unknown star.

The predicted temperature does not always fit as many other factors can come into play.

2.15.3 Managing Planck curves

The screen shows the details of the current Planck curve and provides the ability to navigate, add, edit and hide multiple curves.

Planck curves are listed in the Chart Legend in the descending order of Temperature (i.e. hot curves are displayed above cooler curves).

The Temperature field uniquely identifies each curve so only one Planck curve is allowed per Temperature. If you edit a curve to use an existing Temperature then the previous curve will be overwritten. If you edit the Temperature and Save then a new curve is created using the new Temperature. The original will still exist but is easily discarded using the Delete button.

The Line Width dropdown allows the width to be set or the curve to be hidden

After a Planck curve is saved, the list is resorted and the first curve is selected.

2.16 Resample Profile

The Resample function is available from the main toolbar or under the Tools menu. You must select a profile before invoking this function.

The chosen profile that will be the source of the resample is shown in the caption. The source profile will NOT be overwritten. This function can only add one or more new profiles.

The screen uses Interval and Filter tab headers
2.16.1 Interval tab

This allows the sampling interval to be set that will be applied to a cubic spline curve.

Interval – a dropdown list containing a list of interval values. If the profile is calibrated then the unit will be nanometers, otherwise it will be pixels. You can also type in values that are not in the list.

Reset to [X] – button that resets the interval to the current average interval X.

A smaller interval results in a larger number of points, e.g. setting to 0.5 for an uncalibrated profile will double the number of points.

2.16.2 Filter tab

This screen provides options for applying low or high pass filtering to the profile. A Filter can be used in combination with the Interval value.
Filter Type – A dropdown list containing the following filter types
- Low Pass – use for general smoothing
- Low Pass Gaussian – finer low pass filtering
- High Pass – Signal minus Low Pass value
- High Pass Gaussian – Signal minus Low Pass Gaussian value

Filter amount - a textbox to enter the Filter value. Higher values increase the effect of the filter.

Filter Slider – a horizontal slider bar provides an alternative means of setting the Filter value. Allows changes to be seen in real-time. Use the forward and back arrow keys for fine changes

2.16.3 Common settings
The controls on the base of the screen apply to both the Interval and Blur tab headers

Same Scale as source – A checkbox that overrides the default autoscaling of the Y-axis. This manually scales the filtered profile to the same scale as the source.

*Note: The Same scale checkbox may be better turned off for the high pass filter options.*

Preview – a button to refresh the profile

Add for each open image – a checkbox that will create an additional resampled profile for every open image, when ticked.

Refresh – a button to update the resampled profile after changes have been made.

Add Profile – a button to add a new resampled profile(s) to the chart and then close the form.

The caption of the new profile is concatenated using the original profile name.

Close – close the form without adding a new profile

2.16.4 Producing a linear wavelength profile

Interpolating a calibrated profile will generate a constant wavelength interval between data points. This is useful when the source has a very non-linear calibration (e.g. a prism spectrum).

In the example of a prism spectrum below, the raw blue points are more widely spaced at the red end of the spectrum. The resampled red points are constantly spaced.
2.16.5 Increasing the sampling interval for interpolation

Increasing the interval can have a benefit in a smoother curve making the interpolated min/max easy to visualise.

Note: Choosing too small an interval can just make the profiles unnecessarily large and slow things down.

2.16.1 Using the Low Pass Gaussian option to smooth out noise

Subtle filtering using the Low Pass Gaussian option can be used to reduce the noisiness of a profile without adversely affecting the resolution.
This is a useful tool which can be applied to comparison spectra, to bring a high resolution spectrum to a more appropriate resolution.

2.16.2 Using the Low Pass option to create a continuum

Substantial Low Pass filtering on a profile can be used to generate a smooth continuum that could be used to derive an continuum removal response.

2.17 Animation

The Animation function is available from the toolbar icon or the Tools menu. This will create an animated GIF file from either open profiles or a set of saved pictures.
This function uses the GIF animation component created by gOODiDEA.NET that is licensed under The Code Project Open License (CPOL).

2.17.1 Create animation using open profiles

Use this option button to specify that open profiles in the current BASS project will be animated. The details of each profile, such as colour, the displayed caption and animation sequence are defined in the Profile Properties screen.

The dimensions and colour of the GIF file created will be the same as the chart and can be modified using Chart Settings.

- Use top profile colour – a checkbox to make all frames use the same colour (as the first profile).

- Show each profile added – a checkbox that will add successive profiles to the chart. (Only a single profile is display at once otherwise).

- Captions in sub title – when checked, the legend is hidden and the caption of each profile is displayed in the sub title area above the chart. Obviously, any existing sub title won’t be displayed in the animation. When this option is not checked, profile caption is displayed at the legend start position

- Save each frame – a checkbox that will save each frame to a file. Each file will named ‘Frame + <profile sequence>’ and will be saved in the same path as the output GIF file. A warning will be given when overwriting frame*.png files. Best to manually clear out existing files first.
2.17.2 Create animation from saved pictures

Use this option button to specify that picture files selected will be animated. Using picture files can be more complex, but ultimately allows you greater control to modify each picture in a graphics tool prior to animation.

- Pictures list box – a read only list box that is populated by files selected using the adjacent browse button. Pictures are processed in alphabetical order.

  Files can be removed from the list by selecting and pressing the Del (delete) key.

- Picture browse - a button to browse for picture files to be animated.

2.17.3 Animation settings panel

This contains GIF file options.

- Delay – a textbox to specify the delay (in milliseconds) between frames. Default value is 1000ms (= 1 second).

- Repeat – a textbox to specify the number of times the GIF file will repeat the set of frames. A value of 0 will repeat forever.

- Output file – a textbox containing the file and path of the GIF file to be created.

- File browse - a button to browse for the file and path of the output file.

2.17.4 Remaining screen controls

- Launch output file – a checkbox that will start a Windows process to run the animated GIF file when OK is pressed. Within Windows, a GIF file must be
associated with an application capable of playing an animated GIF (e.g. Internet Explorer) otherwise no animation will be seen.

- Ok – a button to initiate the creation of the animated GIF file in the Output file location.
- Close – a button to close the form.

2.18 Labels Screen

The Labels screen is invoked from a toolbar icon, the main Tools -> Labels menu or the context sensitive chart menu

When the screen is opened, the chart will be in “Add Label mode” with the status bar text shown in green.

The Labels screen provides options to set display colour, text properties and how a line should be displayed. The label itself is created by using the mouse to draw a rectangle on the chart, positioned at the feature to be displayed.

**Note that the font used in labels can be set in the Advanced tab of the Project Settings screen.**

Tab Headers – Select option for:
- Add Label - Set label type and properties of the new label (changes to “Edit Label” if an existing label is being modified).
- Manage Labels – This displays existing labels in a list. This allows any label to be modified or removed.
- Greek Alpha – allows letters from the Greek alphabet to be copied/pasted into label text.

**Label Type** – this panel allows a choice of label types:
- Label Only – displays a text block (without any lines) at the location selected using the mouse on the chart.
- Label & Full Line – as Label Only, but includes a full height vertical line at the start position.
- Free Line & Label – draws a line from the start to the end position where a text block is positioned. Unlike Label & Full Line, this line can be any length or angle.
- Molecular Band – draws a graduated icon at the selected location. The graduation can be left to right or reversed depending on the text justification.

**Colour picker** – allows selection of the text display colour (and line where applicable)

**Text Justification** – these options allow a choice of how text is aligned (justified)
- **Left** – the text is left justified and the text block is positioned to the left of a line (if a line exists).
- **Centre** – the text is centrally justified and the text block is centred on the line (if a line exists).
- **Right** – the text is right justified and the text block is positioned to the right of a line (if a line exists).

**Text Orientation** – these options allow a choice of how text is orientated
- **Horizontal** – text is horizontal
- **Vertical Clockwise** – text is rotated 90 degree clockwise
- **Vertical Anti-clockwise** – text is rotated 90 degree anti-clockwise

**Previous button** – Navigates to the previous label, if applicable. This sets the screen in ‘edit’ mode allowing changes to the current label to be made.

**Remove button** – Removes the selected label

**Add button** – sets the screen in ‘add’ mode ready for a new label to be added.

**Next button** – Navigates to the next label, if applicable. This sets the screen in ‘edit’ mode allowing changes to the current label to be made.

**Save button** – updates the chart with the label and remains in ‘edit’ mode allowing the label just saved to be adjusted/edited.

**Close button** – closes the form

The screen shot below shows some examples.
2.18.1 Adding a label

The screen can be in one of two modes; ‘add’ or ‘edit’ as displayed on the screen caption. Add mode is the default, otherwise press the Add button.

- Select the Line Type.

- Select the position on the chart. The label textbox and/or line (depending on line type) will be positioned at the point where the mouse is used to draw a rectangle or line. This can be the position of the spectral feature line to be annotated.

- The text area will, by default, be populated with the wavelength (or pixel if not calibrated) at the starting label position.

- Overwrite this with your own text. Press the Enter key to format the text with carriage returns (multiple lines) if required.

- Press the Save button to add the label to the chart. (Don’t forget to save the project if you want to keep changes for next time).
Once saved, the screen is in ‘Edit’ mode allowing you to make adjustments or changes. Press the Add button to add more labels.

2.18.2 Editing a label

Clicking on the Manage Labels tab header will display a list showing all the labels on the chart. This and the navigation buttons provide the mechanism by which labels are selected for edit or removal.

Clicking on a row in the list of labels will put the Labels screen in ‘Edit’ mode. This is confirmed by the 1st tab text changing to “Edit Label’ and the screen caption “Label x of y” (where x is the index of the label being edited; y is the total number of labels on the chart).

Changing row will display an editable textbox at the text position, (or draw a border if it’s a molecular band). To change the position of the text, just reselect or draw the new position on the chart.

**Hint** – you may find it easier to temporary save the label out of the way if you wanted to make fine adjustments.

To change the colour, or other properties of the label, double click on the row or click on the Edit Label tab header.
Note: You cannot change the line type (i.e. you can’t change a ‘Label Only’ to a ‘Molecular Band’). This can only be done by deleting the old and adding a new label.

Press the Save button to save changes to the chart. (Don’t forget to save the project if you want to keep changes for next time).

If you don’t wish to save, click on another row, press the Add button or close the screen.

2.18.3 Removing a label

Navigate to the label to be removed then click on the ‘Remove’ button. Confirm removal when prompted.

Removing a label reverts to ‘Add’ mode. To navigate to another label to be removed, either use the previous/next buttons or click on the row in the Manage Labels list.

2.18.3.1 Using Greek letters

Greek letters are widely used in astronomy to identify element lines and in the Bayer Designation of stars. The third tab provides a multiline read only textbox containing the Greek alphabet. This allows letters to be copied/pasted into labels.
2.19 Export Project Data

The Export Project Data function is available from the toolbar icon or the Tools menu. This will export data for all the loaded profiles in a single data table using interpolation to provide intensity values for common wavelengths.

The export requires the top profile to be calibrated.

Start Wavelength textbox – Enter the wavelength the export will start from. The Default value is wavelength of the first pixel from the top profile

End Wavelength textbox – Enter the wavelength the export to. The Default value is wavelength of the last pixel from the top profile

Interval dropdown list – Enter or select the interval between successive rows exported. Lower values will increase the number of points exported (and take longer to process).

Export button – Starts the export

Close button – Close the form
Data is exported to a tab delimited text file selected from a Windows file save dialog.

Once the data file has been saved, you are prompted with the option to launch the file.

Launching the file will run whatever application is associated with the saved filename extension. This is typically Microsoft Excel, but should also work for OpenOffice, or other spreadsheet applications that support tab delimited files. Please allow time for the application to start, this can be 30 seconds or longer.

Select Yes if the spreadsheet application prompts to open the file.

An example of a project export is shown below. As the data is in unformatted tab delimited format, you may need to manually adjust the column widths to suit.
2.20 BeSS Settings

A new ‘BeSS Settings’ screen has been provided that allows the user to update the FITS header with the information required to allow a one dimensional FITS profile to be imported into the BeSS online database. Although only experienced/advanced users would be the most likely to actually submit spectra to BeSS, this functionality and be used by the less advanced to store useful information into the FITS keyword fields.

Start by loading a calibrated one dimensional FITS image.

The new screen is accessed from the “BeSS” button on the General tab of the Profile Properties screen.
The screen provides four tabs to capture the required fields. There is also a tab provided to display error messages when the ‘Validate BeSS’ field is clicked.

2.20.1 Acquisition Reference Data

The first tab collects Acquisition Reference Data.
The Observer, Site Name and Equipment fields provide save and delete buttons to manage locally stored values. These values would need to have been setup in BeSS before files will be accepted for upload to BeSS. The values are held in local text files under the `<BassProject Install>\Reference folder`.

The BeSS standard allows site and equipment to be identified either by a composite name or individual component fields.

Once a Site Name and its components are saved, selection using the Site Name dropdown list will automatically populate Latitude, Longitude and Altitude.

Once an Equipment configuration and its components are saved, selection using the Equipment dropdown list will automatically populate Telescope, Spectrograph and Camera.

The bottom section of the screen is common across all the tabs. This provides

BeSS link – link to the BeSS web site

Reload – button to re-populate the fields with what is currently saved in the FITS header

Validate BeSS - button to validate fields are consistent with the basic BeSS rules. When an error is found, the screen switches to the Error tab which displays each error message and tells the user which tab header is relevant. The validation is local, i.e. there is no real-time connection to the BeSS web site. See the BeSS website for details of the validation.
Save FITs header – button to save the contents of fields to the FITS header and prompt for the file to be saved. This does NOT validate against the BeSS rules.

2.20.2 Object tab

The Object tab allows the object to be specified.

A link to Simbad provides a means to validate the object exists and is of Be type.

2.20.3 Acquisition Details tab

The Acquisition Details tab provides additional information such as calibration and when the object was captured.
The ‘Read from Profile’ button populates calibration data held in a BASS Profile into the FITS header fields required for BeSS.

You can choose to convert between Angstrom or nm by selecting the unit before pressing the ‘Read from Profile’ button.

The FITS header keywords can only store a linear calibration. If a higher order calibration was performed, the average dispersion is used.

The date + time panel allows start and end dates or one date and duration (seconds) to be specified. Date and time values can be adjusted using the date + time picker tools provided. (Dates are saved in the FITS file in yyyy-mm-ddTHH:MM:SS format.

2.20.4 Processing tab

The forth tab provides details of processing and what corrections have been applied.
2.20.5 Errors tab

Shows error messages after the Validate BeSS button has been clicked.

Each message is numbered and the Tab column indicates which tab screen is relevant.

If no errors are detected, a positive confirmation is provided.
The validation checks here are indicative and not as rigorous as BeSS on-line. (For example, there is no local validation that the object is a Be star). The on-line BeSS file checking tool should be used before final submission to BeSS.
3 Appendix A – Calibration Export data file

The calibration export data file mainly aimed at advanced users who understand polynomial regression and can generate appropriate charts using the data exported. The main aim of this is to identify how good the fit will be and in particular if any mathematical inflection has occurred (i.e. if the slope has changed from positive to negative or vice-versa).

The content of calibration data file contains the following:
- A table showing data captured from the data grid in the BASS screen
- The linear best fit line offset and slope
- The polynomial terms according to the selected order
- A table of values over the chart range using the following columns
  - Pixel (column A)
  - Wavelength calculated using Linear fit (column B)
  - Wavelength calculated using the polynomial degree (column C)
  - Delta, the difference between the calculated linear and polynomial wavelengths (column D).

It is beyond the scope of this document to describe every analysis possible. Creating a chart using column D, will show the divergence between the polynomial and linear fits. Adding more calibration points at the ends of the chart can stabilise the curve at the extremes. Some divergence is to be expected because spectra will not be perfectly linear.
4 Appendix B - Known issues

The known issues are listed below:

- The chart excludes the number of pixels corresponding to any manual image strip offset alignment for un-calibrated profiles.

- Intermittently, on application startup, an error message as shown in the image below may be raised. Pressing continue is normally fine. If in doubt restart the application.
5 Appendix C – Rotate/Tilt/Smile/Slant correction

The following examples illustrate some of the different issues that can be apparent on spectral images and help clarify the terminology used.

The first image represents a correct image where the dispersion is horizontal and the absorption (or emission) lines are vertical.

![Correct Image]

The next image shows a spectrum rotated. The dispersion is not horizontal and the lines are not vertical. This can be caused by the camera not being horizontal to the dispersion axis (of the prism or grating).

![Rotation Image]

The next image shows Slant. The dispersion is horizontal, but the lines are not vertical. This can be caused by the slit not being vertical, or by trailing on a moving target when not using a slit. Capturing a slit-less spectrum without an RA driven mount can also produce slant.

![Slant Image]

The next image shows Tilt. The dispersion is not horizontal, but the lines are vertical. This can be caused by rotating the camera to compensate for a non-vertical slit.
The next image shows Smile. The lines are curved. This can be caused by optical misalignment or other aberrations. This issue is more likely to be seen in Littrow spectrographs.

Of course, the issues can also appear in combination, for example slant + smile as shown below.
## Appendix D – Amendment History

<table>
<thead>
<tr>
<th>Version/Date</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Doc v0.0.1 for BASS Project v0.0.1 | First draft version  
Some sections still to be updated |
| Doc v0.0.2 for BASS Project v0.0.2 | Changes  
Updates to the calibration & response correction sections of the user guide.  
Auto scaling bug fix when zoomed in on reference spectra as second profile. |
| Doc v0.0.3 for BASS Project v0.0.3 | Changes  
Setup Installation package created (with uninstall option)  
New Image processing functions (for FITS images only):  
- Crop image to new size  
- Set active binned and background regions per image  
- Black & White levels adjustment  
DAT (space character delimited) text file profiles can be imported and exported. This makes it easier to exchange information with other spectroscopy applications.  
The Continuum & Profile Shaper screen is more compact and now uses cubic splines (rather than a polynomial fit) for response shaping. This enables more accurate instrument response and continuum corrections. The `.\Instruments\Coefficients.dat` file is superseded by a new `.\Instruments\ResponseCurves.dat` file. Existing corrections will need to be regenerated as there is no migration of old polynomial coefficients to the new cubic spline data point format.  
The file extension `".info.dat"` (used for profile shadow files that hold profile attributes) has been changed to `".info.bas"`. This will minimise confusion with `".dat"` profile files. Existing `.info.dat` files will be automatically be renamed to `.info.bas` when profiles are loaded.  
Navigation through open profiles is easier as buttons have been added to the Profile Properties screen. Alternatively, the user can also just double click on an image strip.  
The Planck Temperature curves screen now allows multiple curves to be managed  
The false colour rendering of binned image strips has been improved  
The Y-Axis Labels option to display FITS intensity as 0-255 range as been discontinued. FITS files will now always use ADU (to keep it simple).  
Fix for known issue of invalid min/max X-axis crop values  
Fix for known issue where a Planck curve ended up as Top profile.  
Fix for improved resolution of reference spectra |
<table>
<thead>
<tr>
<th>Doc v0.0.4 for BASS Project v0.0.4</th>
<th><strong>Changes</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New FITS image processing functionality for image rotation (tilt correction) as well as smile and slant correction</td>
</tr>
<tr>
<td></td>
<td>Save icon added to toolbar</td>
</tr>
<tr>
<td></td>
<td>False colour 10% boost in colour image strip views</td>
</tr>
<tr>
<td></td>
<td>DAT file export format includes a space + tab character (to allow Excel paste).</td>
</tr>
<tr>
<td></td>
<td>Planck curves can now be exported as DAT profiles</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Doc v0.0.5 for BASS Project 0.0.0.5</th>
<th><strong>The Correction tab in the Profile Properties screen now includes an option to use (divide by) a specified response profile. This ‘traditional’ approach makes BASS more compatible with other applications. The screen labels and explanations in the user guide have been amended to make this clearer.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The ‘Use Correction from 1st Profile’ option has been discontinued from the Profile Properties screen (as the ‘Named Spline’ and ‘Response File’ options provide equivalent or better functionality)</td>
</tr>
<tr>
<td></td>
<td>New Profile Resample screen. This allows a profile to be resampled to alter the interval between pixels. Options are provided to output at a constant wavelength interval and/or apply blurring (may be useful to generate a continuum)</td>
</tr>
<tr>
<td></td>
<td>Enhancement to Export Project Data. The main project export (tool bar icon) now presents multiple profiles in a single table, interpolating when necessary. A choice of wavelength range and wavelength interval options is provided.</td>
</tr>
<tr>
<td></td>
<td>The user is prompted to save a new profile before it can be calibrated.</td>
</tr>
<tr>
<td></td>
<td>Up &amp; down spinner widget controls have been provided for setting Rotate and Slant settings</td>
</tr>
<tr>
<td></td>
<td>Where a profile is configured with instrument or continuum removal, this will be applied before a mathematical operation (such as division)</td>
</tr>
<tr>
<td></td>
<td>Fix - Continuum Shaper screen can track profile intensity when Y scaling and Y offset options are not 100% &amp; 0% respectively.</td>
</tr>
<tr>
<td></td>
<td>Fix – Intermittent ‘Unable to find unique solution’ message during measurements</td>
</tr>
<tr>
<td></td>
<td>Fix - Planck curve was not displayed if x-axis started below 0 nm</td>
</tr>
</tbody>
</table>
Calibration tab of the Profile Properties screen. A "Copy" button has been added within the “Use Calibration from First Profile” option. This will use the calibration dispersion from the 1\textsuperscript{st} profile and calculate any offset, (from alignment of image strips), to populate the calibration coefficients of the profile being edited.

Loading and processing times are improved for FITS or RGB (bitmap) images.

RGB images are now imported as if FITS files. This allows image processing such as crop, rotation and level setting to be applied to RGB images (as well as FITS images).

RGB images can now be saved as FITS files

Spelling and grammar amendments to user guide. The word spectra should no longer be used in a singular context.

Chart Settings screen. A new “Default” button allows your preferred chart and project settings to be used when a new project is created.

User Labels Screen – A line is now only displayed if the ‘show line’ check box is ticked

Messages to select an active profile have been standardised. If only 1 profile is loaded, then it is selected by default.

The title, sub title and notes fields in the chart settings screen can now contain embedded commas. This also applies to profile captions.
| Doc v0.0.7 for BASS Project 0.0.0.7 | The Labels screen now allows labels to be individually managed (deleted or edited).
| | The ‘Selection’ menu has been moved out of the ‘Image’ menu into root menu. (This means less clicks are required for cropping an image or setting binned and background regions).
| | A user is prompted for unsaved image changes when an image is removed or a project is closed.
| | The new Image -> Bulk Image processing menu option allows image processing options to be applied to multiple images
| | The Black and White levels screen provides an option to apply the settings to multiple images
| | The Rotation screen provides an option to apply the settings to multiple images. In addition, the correction angle can be set by drawing a line on the image.
| | The Rotation screen provides a separate option for “tilt” correction. This allows tilt correction as a single process (where previously it required rotation followed by slant correction).
| | The Smile/Slant Correction screen provides an option to apply settings to multiple images. In addition, the slant angle can now be set by drawing a line on the image.
| | The Resample Profile screen provides an option to apply settings to multiple images.
| | *Note that the new multiple image functionality is intended primarily for a small number of slit spectrometer images that don’t require alignment. Readers should be familiar with processing images on an individual basis before processing in bulk.*
| | Disabled manual alignment of image strips, (the ability to slide images), when the Image Strip View dropdown list has a ‘stretch’ mode selected.
| | The `.\Reference\Lamdadata.dat` file used for calibration contains more Neon lines to help in the calibration of slit spectrometers.
| | The DAT file import has been modified to allow multiple column formats of reference spectra to be imported (with line feed or carriage return + line feed row separators).
| | Fixed for intermittent “Invoke or BeginInvoke cannot be called..” error message on application start up on slow/busy machines
| | Fixed issue when the saved default profile width exceeded the actual image width
| | Fixed issue when performing a calibration using x-axis crop to zoom in and out
### Doc v0.0.8 for BASS Project 0.0.0.8

New Label screen offers more flexibility. Now provides options for: lines to be drawn at any angle or length, text alignment, text orientation and also includes the ability to add molecular band icons.

Cancelling a calibration edit part way will automatically revert back to previous state, (previously this required calibration and correction to be manually reset).

New Hot Pixel screen allows removal of hot pixels and creation of ‘cosmetic’ files. This screen is work in progress.

A new “exceeds background” binning option has been added (Chart Properties -> Advanced menu). Additional binning algorithms can be added at a later stage on request.

Fixed issue calibrating to sub-pixel accuracy at high x-axis zoom.

### Doc v0.0.9 for BASS Project 0.0.0.9

Animation screen – a new screen that allows an animation to be created from a set of profiles or picture files.

Profile Properties screen - Y-Axis manual scaling options added as new tab

Calibration Screen – now uses automatic detection of the min/max calibration point based on a range selection. The previous ‘double click at the point’ method is still available if the shift key is held down.

Calibration Menu – this now includes an option to remove calibration data (points and coefficients) from the first profile. Useful for a clean re-calibration.

The Resample Profile screen has been improved and simplified
- Removed linear interpolation choice, as it’s simpler to always use ‘spline’
- Removed resampling unit interval choice, as it’s simpler to just use nm or pixel according to calibration status
- The interpolation and blur functionality is now split across tab headers
- The Blur tab includes a slider to see the effect in real-time

File menu has a new option to split a colour RGB image into separate red, green and blue channel profiles

Labels screen - A new “Greek Alpha” tab provides a convenient source of Greek letters for pasting into labels

Hot Pixel screen - Improvement to removal & detection of hot pixels. File format of cosmetic file changed to IRIS space delimited format

File open and save dialogs – improvements to default values
- Default project filename is blank for new projects (with the folder defaulting to previously saved project)
- Default Export filepath is same as last saved project.
- Default location to save a DAT profile to is the same as used to open the last image/profile

X-Axis crop screen. Improved validation against pixel and wavelength range.

Labels screen – Bug fix. Text justification options now also apply to “Label Only” label type

Profile Properties screen – Bug fix. The filename textbox is now read only

The appendix in this document showing a comparison with the original BASS application has been removed.
| Doc v0.0.1.0 for BASS Project 0.0.1.0 | Measurements & Elements screen  
Calculations of max, min, FWHM using spline fit  
New Equivalent Width calculation and graphical representation  
Report menu allows choice of which details are reported  

Image Resize screen. New screen available under the Image menu to resize images.  

Region Selection Tool. New screen available under the Image menu. This allows fine control of binning and background regions set using the mouse.  

Calibration screen – Now allows a one point calibration. Press Finish with one point defined then enter the dispersion factor into the popup box provided  
Note that the average dispersion factor of the selected profile is now displayed on the status bar.  

Animation screen. The form is disabled during processing. Watch the status bar on the main chart to see animation progress.  

Profile Properties – Y Axis tab.  
New ‘Multiplier’ and ‘Offset’ textboxes allow raw data flux values to be rescaled.  

Hot Pixel screen. Enhancement to allow finer adjustment of threshold.  

X Axis Crop screen  
Validation of min and max bounds now occurs when Ok is pressed. This also fixes a bug editing of minimum wavelength.  

Image Strip View  
Bug fix – Profiles using image alignment shift were not rendered correctly when the image strip view was set to Synth Binned Stretch or Synth Colour Stretch.  

0.0.1.1 | A border is rendered around the active image strip to make it easier to indicate which profile you are working on.  
A new ‘Copy Image Strips to clipboard’ option has been added to the ‘Chart’ menu.  
This does not show the border that is rendered around the active image strip  

Signal to noise ratio and standard deviation added to Measurements screen report  

Signal to noise ratio and standard deviation added to status bar statistics (when an area is selected on an image)
| 0.0.1.2 | New image stacking screen. This performs stacking and alignment of 2 dimensional images. Also supports processing using dark, bias and flat files.

The Measurements & Elements screen is now split into three tabs. One tab contains the fields to be included in the results and provides textboxes to allow repeatable runs.

A new BeSS Settings screen has been created to update FITS header to meet requirements for uploading to the online BeSS database.

Simplification of labels used for Profile Properties Correction tab and Continuum screen (actual functionality is unchanged). ‘Spline#1 and #2’ are replaced with ‘Instrument Correction’ and ‘Continuum Removal’. ‘Common Named response’ is now ‘Master ResponseCurves.dat’

The second tab on the Resample Screen has been changed from a Low Pass with a Gaussian option, to now allow filter types (including new high pass) to be selected from a dropdown list.

Bulk Image Manipulation screen now allows all files in project to be saved with a filename prefix.

The Export to Profile option now allows export to FITS and DAT format, (previously was DAT only).

Chart main menu provides new options to save the chart and image strips as bmp, png or jpg files.

If the Shift key is held down when a profile is being removed, then an option will appear allowing the actual file (and associated *.info.bas image settings file) to be deleted from disc. (The deleted file is moved to the Recycle Bin where possible).

Reference Spectra list now shows hot ‘O’ and ‘B’ class stars first.

Animation Screen now allows cancel during processing

The min and max wavelength limits, (in Project Properties -> Advanced tab), don’t apply to operations on un-calibrated profiles.

Revision History section moved to the end of this document as an appendix

Planned Enhancement section removed from appendix |
| 0.0.1.3 | Region Selection Tool – A description of this screen has now been added to this document.  
Stack and Align Profiles - A description of this screen has now been added to this document.  
Chart Settings screen  
Allows a background image file to be displayed in the chart behind the profiles.  
Allows a caption for the y axis to be specified  
Allows x axis captions (calibrated & raw) to be specified  
Separate x axis and y axis tabs  
Doppler x axis – New functionality (triggered in x-axis tab of Chart Settings) to display velocity on x-axis of chart  
FITS header screen – provides insert & delete options  
Save to 1D profile  
New screen that supersedes as Export To 1d function.  
Calibration Line screen  
This now 'remembers' the last element.  
A browse button has been added to allow the calibration lines data file to be chosen.  
Hot pixel screen  
Detection of hot pixels can now be restricted to a selected area. Option added to replace hot pixel values with pixels to the left & right only  
BeSS Settings screen  
The Site and Equipment dropdown lists now also store and display the components, (e.g. Site Name now saves latitude, longitude and elevation). The Save FITS Header button will now prompt to save the FITS image.  
Image menu  
The Image menu is now enabled for any Image Strip View dropdown list selection (when an image is clicked). Items within the Image menu that apply to a 2d image are only enabled when Image Strip View = 'Raw Image'.  
New sub menu item for 'BeSS Settings' added.  
Selection menu  
New exclusion region added to the menu and also to the Region Selection tool. |
The following bug fixes have been incorporated into the 0.0.1.3 release

- Measurements screen. The wavelength displayed was not accounting for the alignment relative to the top image strip when the image was only ‘temporary calibrated’.

- Wavelength & intensity values were incorrectly displayed on the LH status bar when the profile had a 'temporary calibration'.

- Stacking screen - Some parameters such as start + end date and duration were not being populated into the FITS Header if the ‘no alignment’ option was select

- FITS Save - Fixed an over padding of empty bytes at end of FITS file issue, (as reported by the BeSS file validation tool). In addition, numeric keyword values are now right justified.

- FITS files can now also accept padded value for FITS keyword CUNIT1 nanometer unit (e.g. 'nm      ').

- File and/or project close now prompts to save an image after a slant correction was applied.

- Calibration Lines screen - Deleting a calibration point no longer sets the 'calibration fit' to cubic polynomial.

- Resize screen - active binned region height was not rescaled following image resize.

- Smile/Slant screen. The 'Apply to all images' checkbox was not working when the Smile tab was selected.

<table>
<thead>
<tr>
<th>1.3 rev 1</th>
<th>Flux Normalisation screen – Split onto two tabs. First tab allows direct input of the wavelength range to be normalised to 1. The other ‘advanced’ tab allows various manual options.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.3 rev 2</td>
<td>R (resolving power) calculation added to FWHM measurement (when profile is calibrated)</td>
</tr>
<tr>
<td>1.3 rev 3</td>
<td>The ‘File’ tab of the Profile Properties screen is renamed to ‘General’ and includes a new checkbox that allows image strip display to ignore y axis scaling changes The ‘Display’ tab of the Profile Properties screen is renamed to ‘Line’ and includes a new dropdown list allowing a choice of line styles (e.g. dash, dot). Bug fix – Pressing the Apply button twice on the Normalise Flux screen will no longer toggles between original and normalised values. Bug fix – The Export Project function was not including the calibration parameters for profiles using the “Use FITS Header” calibration option.</td>
</tr>
</tbody>
</table>
| 1.3 rev 4 | Line marker added to Plank curves
Crop to Image selection – prompt before cropping |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.4</td>
<td>Selection of Angstrom, Nanometre or Micron wavelength unit (via Advanced tab of Chart Properties)</td>
</tr>
</tbody>
</table>